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Important Notice

Because of the nature of wireless communications, transmission and reception of data can never be guaranteed.

Data may be delayed, corrupted (i.e., have errors) or be totally lost. Although significant delays or losses of data are
rare when wireless devices such as the Sierra Wireless modem are used in a normal manner with awell-constructed
network, the Sierra Wireless modem should not be used in situations where failure to transmit or receive data could
result in damage of any kind to the user or any other party, including but not limited to personal injury, death, or loss
of property. SierraWireless, Inc., accepts no responsibility for damages of any kind resulting from delays or errors
in data transmitted or received using the Sierra Wireless modem, or for failure of the Sierra Wireless modem to
transmit or receive such data.

Safety and Hazards

Do not operate the Sierra Wireless modem in areas where blasting is in progress, where explosive atmospheres may
be present, near medical equipment, near life support equipment, or any equipment which may be susceptible to any
form of radio interference. In such areas, the Sierra Wireless modem MUST BE TURNED OFF. The Sierra
Wireless modem can transmit signals that could interfere with this equipment.

Do not operate the Sierra Wireless modem in any aircraft, whether the aircraft is on the ground or in flight. In
aircraft, the Sierra Wireless modem MUST BE TURNED OFF. When operating, the Sierra Wireless modem can
transmit signals that could interfere with various onboard systems.

The driver or operator of any vehicle should not operate the Sierra Wireless modem while in control of avehicle.
Doing so will detract from the driver or operator’s control and operation of that vehicle. In some states and
provinces, operating such communications devices while in control of avehicle is an offence.
Patents
Portions of this product are covered by some or al of the following US patents: D367062, D372248, D372701,
5515013, 5617106, 5629960, 5682602, 5748449, and other patents pending.
Copyright

©1999 Sierra Wireless, Inc. All rights reserved.
Printed in Canada.

No part of this publication may be reproduced, stored in aretrieval system, or transmitted in any form or by any
means, without the prior permission of the publisher.

Theinformation in this manual is subject to change without notice and does not represent a commitment on the part
of SierraWireless, Inc. SierraWireless, Inc. shall not be liable for incidental or consequential damages resulting
from the furnishing, performance, or use of this manual.

The Watcher and WirelessExpert™ software described in this manual are copyright 1998 Sierra Wireless, Inc. All
rights reserved.

Trademarks
Watcher and WirelessExpert™ is atrademark of Sierra Wireless, Inc.
Windows® and Microsoft® are registered trademarks of Microsoft Corporation.
Hayes" is atrademark of Hayes Microcomputer Products, Inc.

Paradyne™ is atrademark of Paradyne Corporation.
ETC® isaregistered trademark of Paradyne Corporation.

All other brand or product names, logos, trademarks, etc. mentioned in this manual are owned by their respective
companies.
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Regulatory Information

The equipment certifications appropriate to your device are marked on the device and the accompanying product
specific information. Where appropriate, the use of the equipment is subject to the following conditions:

‘. CAUTION

Unauthorized modifications or changes not expressly approved by Serra Wireless, Inc.
could void compliance with regulatory rules, and thereby your authority to use this
equipment.

m WARNING (EMI) - United States FCC Information

This equipment has been tested and found to comply with the Class B limits pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in an appropriate installation. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio
communication. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interferenceto radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

Reorient or relocate the receiving antenna

Increase the separation between the equipment and receiver

Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected

Consult the dealer or an experienced radio/TV technician for help

m WARNING - FCC RF Exposure Guidelines

While this device isin operation, a separation distance of at least 20cm must be
maintained between the radiating antenna and the body of all persons exposed by the
transmitter to meet FCC exposure guidelines.

This transmitter is only approved to operate with an antenna not exceeding 1.5 watts
total system ERP (effective radiated power) for operations with the antenna located at
more than 20 cmfrom all persons. The warning label must be displayed at the base of
the antenna (if stand-alone) or attached to the final product (if the antenna is integral
with the product), clearly visible to all persons exposed to the transmitter.

For Final Product Regulatory Approvals in the USA

To use the modems in the United States of America without additional FCC certifications you
must:

1. Usean antenna providing atotal system ERP (effective radiated power) not exceeding
1.5 watts for operations with the antenna located at more than 20 cm from all persons. If the
system exceeds 1.5 watts ERP then separate submissions to the FCC are required.

2. Place awarning label on the antenna (if stand-alone) or attached to the final product visible to
all persons exposed to the transmitter (if the antennais integral with the final product). This
label must state:
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“WARNING:
Whilethisdeviceisin operation, a separation distance of at least 20cm must be
maintained between the radiating antenna and the body of all persons exposed to the
transmitter to meet FCC exposur e guidelines.”
3. Theword “WARNING” should be placed in front of or above the warning statement included
in documentation and aso in the actual warning label on the antenna or final product.

Thiswarning label is not required when Specific Absorption Rate (SAR) compliance of afinal
product configuration is approved through a separate FCC equipment authorization approval.
Otherwise, the warning label is required on the antenna or final product in order to meet separating
distance requirements to satisfy the FCC RF exposure requirements.

m WARNING (EMI) — Canada

This digital apparatus does not exceed the Class B limits for radio noise emissions
fromdigital apparatus as set out in the interference causing equipment standard
entitled 'Digital Apparatus, |CES-003 of the Department of Communications.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux
appareils numériques de Classe B prescrites dans la norme sur le matériel brouilleur:
'Appareils Numériques, NMB-003 édictée par le ministre des Communications.

RSA Licensee

If you have purchased this product under a United States Government contract, it shall be subject to
restrictions as set forth in subparagraph (c)(2)(ii) of Defense Federal Acquisitions Regulations
(DFARS) Section 252.227-7013 for Department of Defense contracts, and as set forth in Federal
Acquisitions Regulations (FARS) Section 52.227-19 for civilian agency contracts or any successor
regulations. If further government regulations apply, it is your responsibility to ensure compliance with such
regulations.
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Contact Information

SierraWireless, Inc. Telephone: (604) 231-1100

13575 Commerce Parkway Fax: (604) 231-1109

Suite 150

Richmond, BC e-malil: support@sierrawirel ess.com
V6V 2L1 Web: Www.sierrawirel ess.com

Customer Service

Help Desk
Open between 6:00 am. and 5:00 p.m. Pacific Time
(604) 231-1128

support@sierrawirel ess.com

Warranty and Service Desk
Open between 8:00 am. and 5:00 p.m. Pacific Time
(604) 231-1157
support@sierrawirel ess.com

Sales Desk
Open between 8:00 am. and 5:00 p.m. Pacific Time
(604) 231-1100
sales@sierrawirel ess.com

Web

Consult our webpage for
up-to-date product descriptions, documentation,
application notes, firmware upgrades,
troubleshooting tips, and press releases:

WWW.sierrawireless.com
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SIERRA WIRELESS

HEART OF THE WIRELESS MACHINE™

1. About this Guide

1.1. Introduction

This guide is intended to assist both hardware integrators and application software devel opers with
the setup, installation, testing, and design of applications for the Sierra Wireless SB300 Series
OEM modems. Y ou should be familiar with the use of modems, communication media (PSTN
and Cellular), protocols, and the use of AT commands.

This guide describes the full feature set of the entire SB300 series, so some sections may not apply
to the particular model you are using. Consult the Product Descriptions for a summary of the
features available on each product.

1.1.1. Getting Started

Chapter 2 covers the setup up of the OEM Developer’s Toolkit (the toolkit) and establishing host
communication with the modem. If you have any uncertainties about the Multipurpose Interface
Board (MIB), the modem, or the connectors, consult the Hardware View reference chapters.

1.1.2. Operational View

The main body of this document covers the operational issues of the SB300 Series modems.

Installation and use of the application software Watcher and WirelessExpert ™ is covered. These
programs are designed to manage use of the modem in a Microsoft Windows® 95/98/NT
environment without the need for further interface programming.

If custom applications are required, additional information is provided covering connection issues
and tips for writing applications. A complete reference to the available modem commandsisin a
separate document (2110031 included with the toolkit).

Use of aterminal application for initial setup and testing of amodem may be required. Terminal
emulation software is not provided nor described in this guide.

1.1.3. Hardware View
This guide provides product descriptions of the SB300 Series OEM modems including the
information needed for the physical integration of the modems.

A full description of the Multipurpose Interface Board provided with the OEM Developer’s
Toolkit is also included in this guide.

2110059 Rev 1.1 Proprietary and Confidential Page 1



SB300 Series User's Guide

1.1.4.

OEM Developer’s Toolkit Checklist

Y our toolkit should include the following parts:

SWI Part No. Description

1200054 Multipurpose Interface Board (MIB)

1900000 AC Adapter

006.0011 10’ Serial Cable with 9-pin D connectors

2000068 30-Pin Flat Flex Cable (for SB300 and SB320)

2000071 13-Pin 1/O Connector Cable (for SB320)

1710034 13-pin Mae SB320 Connector sample

1710134 13-pin Female SB320 Connector sample

1810009 Magnetic Mount Cellular Antenna with coaxial cable

2000066 Cable Adapter for antenna coax to SB modems. (MMCX to SMA)
006.0002 Telephone Cable

1900003 Headset with Microphone, cable and connector.

2000067 16-Pin Ribbon Connector Cable (for SB302)

6000084 CD with Watcher and WirelessExpert™ Revision 3.3.1 or above.
2110031 SB300 Series OEM Modems AT Command Reference

2110059 SB300 Series OEM Modems User’ s Guide (this document)

1.2. References

For detailed information on the command interface of an SB300 Series modem, consult the Sierra
Wireless SB300 Series OEM Modems AT Command Reference, document number 2110031,
included in toolkit.

For background information on the nature of wireless communications consult your cellular
service provider and/or their Internet site. All major service providers provide web-based
information on CSC and CDPD.

1.3. Currency

This document is under ongoing revision to maintain currency with product development. Please
check our web site frequently for revisions. This edition is:

Rev 1.1 June 22, 1999

This document is current with the following modem firmware revisions:

SB300

Revison R1.1.1. To determine your firmware revision:

1. Enter the Identification command ATI5
The modem will respond with the Firmware revision information:
R1-1-1 ...

The details following the revision number may vary depending on the mode of the modem.

Page 2
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SB320

Revison R1.1.2. To determine your firmware revision:

1. Enter the Identification command ATI5
The modem will respond with the Firmware revision information:
CDPD Mode: R1.1 2..
CSC/Wireline Modes: (no tag) g:/sb3xx/r1_1 2/ ...

If the identification command isissued in any of the wireline or CSC modes, this firmware
provides no revision tag, however the revision is found farther down the string.

Upgrading

If your modem firmware is an earlier version, you can acquire updated firmware by contacting
SierraWireless Technical Support at 604.231.1128 or by e-mail to support@sierrawirel ess.com.
Instructions for updating the modem firmware are contained in Section 3.8 Updating Modem
Firmware.

Descriptions of Watcher and WirelessExpert are current with revision R3.3.1. Therevisionis
reported in the splash screen when the program is started and can be checked using the Help >
About option from the program’ s menu.

1.4. Document Structure

This document focuses on the operational view. The hardware view is covered in areference
section at the end.

Thereis a Getting Started chapter in this section intended to help you quickly get the toolkit
components connected and communicating.

The operational view follows, starting with the basics of the Watcher and WirelessExpert™
software provided with the toolkit. Important background on the modem basics, including
terminology used in this guide, starts you into the operational elements of getting your modem
configured and operating. There are separate chapters covering modem operation in each of the
three possible modes with sample configurations.

The hardware view is covered in two chapters. The first describes the modem product
descriptions including the hardware integration issues of each of the modems. The second isa
reference to the Multipurpose Interface Board (MIB) used to test and configure the modem during
product development.

1.4.1. Modem Operations

The various modes, states, and conditions the modem can be placed in are described in the chapter
on Basic Modem Operations. That chapter also discusses the communication interface between
the host (DTE) and the modem.

The types of protocols supported in each mode are described but examples of configuring the
modem will be found in the chapters on operations for each specific mode.
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1.5. Conventions Used in this Reference

@ WARNING
Notes in this form denote a physical hazard. The warning calls attention to a
procedure or practice which, if not performed correctly, could result in personal injury.

CAUTION

Notes in this form highlight a procedure or practice which, if not performed correctly,
could result in loss of data or damage to equipment. Thisis also used to highlight
issues related to regulatory limitations.

-
L
|

NOTE

This form of note draws attention to procedures or practices which, if not performed
correctly, could result in failure of a process or improper configuration. These are
typically pre-requisites to other operations.

Hardware signals are named with a convention of:

NAME active high (5 Volts)
\NAME active low (0 Volts)

Result Code — Thisis anumeric or text code that is returned after all commands (except resets).

Response — This term indicates a response from the modem which isissued prior to areturn code.
Reading registers or issuing commands that report information will provide a response followed
by a return code unless the command generates an error.

Hexadecimal values are shown with a prefix of 0x, i.e. in the form Ox3F.

Character codes which are described with words or standard abbreviations are shown within angle
brackets: such as <CR> for Carriage Return and <space> for a blank space character.

AT Command and register syntax is noted using an aternate font:
AT+WS46=4
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2. Getting Started

2.1. Introduction

This chapter guides you through the initial physical setup of ahost terminal (usually a PC), the
Multipurpose Interface Board (MIB), and amodem. Related start-up issues such as cellular
activation are also covered. If you have any difficulties, consult the reference chaptersin the
Hardware View to become more familiar with the components and their setup.

After completing this chapter, you should be able to communicate (DTE to DCE) with the modem
by using AT commands from a host terminal. Modem connection to a remote modem is not
covered until the Operational View.

The chaptersimmediately following deal with the Operational View. Software Installation will
deal with the installation on a host PC of the Watcher and WirelessExpert™ software which make
further configuration of the modem and testing on a CDPD network (if applicable) much simpler.

A reference section covering the Hardware View follows at the end of the manual.

2.2. Registration

2.2.1.

Before you can use your modem for wireless communication you must register it with a cellular
service provider. This section describes what they will need to know and what information they
will provide to you.

Contact your service provider to get the registration process started. While the service provider is
getting your account configured, you can install and configure your modem. Record the
information provided by your carrier for configuring the modem later.

In any coverage area there can be two providers, each assigned to a“side” (A or B) of the cellular
waveband. Each provider is also assigned a Service Provider Network Identifier (SPNI) number.

CDPD

To use your modem in CDPD mode it must be activated on a CDPD network. To register your
modem for Wireless I P activation on CDPD networks, contact your local CDPD service provider.

Give the CDPD service provider the Equipment Identifier (EID). Thisisthe identification
number of the radio/modem. A Sierra Wireless modem EID has the following format:
00-A0-D5-xx-xx-xX

Look for this number on the back of your modem and on alabel affixed to the outside of the
package that the modem was shipped in. If only the ESN (Electronic Serial Number) can be found
you can convert it to a Sierra Wireless EID by expressing the last 8 digits as hexadecimal values.
For example:

ESN: 206 - 00057628
57628

EID: 00-A0-D5-00-E1-1C
OxE11C

The EID number is also available by querying the modem with the AT+WPEID command.

The CDPD service provider supplies the following:

1. Modem address, commonly referred to as a Network Entity Identifier (NEI). Thismay also
be referred to as your Internet Protocol (IP) address. Thisidentifies your modem on a CDPD
network and on the Internet.

2. |P address of arouter or server to ping when testing the connection. This may be a Domain
Name Server (DNS).
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2.2.2.

2.2.3.

Both of the above items are in the form of an IP number. Thisis made up of four numbers
ranging in value from O to 255, separated with periods (sample: 192.168.0.9)

3. Sidedesignator, A or B. Thisis determines the channels used by your CDPD service
provider.

4. SPNI number of the provider. Thisisoptional. The Service Provider Network Identifier
(SPNI) can be used to restrict the modem to accepting service from alimited list of providers
and can help speed up cellular channel acquisition and registration.

This information will be required when configuring your modem for CDPD registration either
with WirelessExpert or AT commands.

CSC (AMPS)

To use your SB320 modem in CSC mode it must be activated with a cellular phone service
provider. To register your modem for CSC activation, contact your local cellular carrier.

Give the service provider the Electronic Serial Number (ESN). Thisisthe identification number
of the radio/modem. A Sierra Wireless ESN has the following format: 206-xxxxxxxx. Look for
this number on the back of your modem and on alabel affixed to the outside of the package that
the modem was shipped in. The number is also available by querying the modem with the
AT+WVESN command.

The cellular service provider supplies the following:

1. A Number Assignment Module (NAM). Thisisyour cellular telephone number and your
Home System ID (SID).

2. Sidedesignator, A or B. This determines the channels used by your service provider.

This information will be required when configuring your modem for CSC mode use either with
WirelessExpert or AT commands.

Wireline

There are no particular setup issues to configure your SB320 modem for use in wireline mode. 1t
isrequired that the telephone line be analogue - not digital as found on some PBX systems.

2.3. Setup Considerations

2.3.1.

Host Computer Terminal

Y ou will require a PC with a communications program capable of operating in ASCII terminal
emulation mode. This allows the PC to function as aterminal attached to the modem and permits
the entering of AT commands required for modem setup and diagnostics. We recommend that the
program chosen be capable of logging terminal communications activity to afile for later analysis
or printout in the event that technical support is required.

For IBM PC-compatibles, Windows Terminal, Hyperterminal, Procomm, and Kermit are all
acceptable. Note that early versions of Hyperterminal do not alow you to send SLIP framing
characters to the modem, preventing use of the escape sequence. Thisis corrected in later
versions.

A 9-pin D connector RS-232 seria cable (part number 006.0011) is provided with the OEM
Developer’s Kit for connecting the PC host to the Multipurpose Interface Board.

Page 6
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2.3.2. Physical considerations

NOTE ‘

X » »
k‘) The MIB and modem can be sensitive to static so the work surface should be a \
static controlled environment. R

2.3.3. Antenna considerations

The SB300 Series modem uses standard mobile cellular radio signals. An antenna (part

number 1810009) is provided with the OEM Developer’'s Kit. Along with thisantennaisa
connector adapter (part number 2000066) to convert the antenna connector (Male SMA) to match
the modem requirement (Male MMCX).

Y ou can use an antenna of your own if you choose. Any standard cellular antenna of good quality
will function properly provided you have a suitable connector.

CAUTION

The combination of cable loss and antenna gain must yield an overall system gain not
exceeding 0 dB. The transmitter output of 0.6 Watt is delivered at the connector. This
isthe FCC regulated limit of a Class | device.

P
£ @
|

Antenna performance is subject to the following guidelines:

L ocation — Locate the antenna as far away from personnel as possible to minimize signal
blocking. For optimum reception in indoor fixed location applications, position the antenna above
the height of personnel and nearby equipment or structures. Locate the antenna as closeto a
window as possible.

Cabling — Select alow loss, high quality, 50-ohm, coaxial cable with the appropriate connectors.
The cable can be any length, but lengths greater than 4 metres (13.1 feet) increase cable loss and
offset the antenna’ snominal gain. If longer length cables are required, use a heavier wire gauge to
reduce the dB loss/m and to minimize the effect of the cable loss on antenna gain.

Ground Plane — For installations where a good antenna ground plane (metal surface) is not
available, use a non-ground plane type of antennato help maximize signal reception.

Proximity to Other Antennas— In general, do not locate the SB300 Series modem antenna closer
than 1.5 metres (5 feet) to another antenna. In certain cases even more separation isrequired. The
effect of the interference from two-way transmitters varies from slowing down response times to
blocking modem transmission.

The SB300 has recently had hardware modifications to support an upcoming Sierra Wireless
3-Watt booster.

CAUTION

In cases where the antenna output is to be connected to test equipment, DC blocks must
be used on the antenna output to protect the test equipment and avoid fal se booster
detection..

P
£ @
|
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2.4. MIB Presets

The Multipurpose Interface Board has several switches and jumpers which should be configured
asfollowsfor the initial setup.

DIP Switch in the Serial Breakout Box:

Switches 1 through 8 should be closed (on)

Switches 9 and 10 open (off).

Power Select (J21) should be on pins1 —2 (+5V).

HOSTSHDN, \SHDN, and MODEM DIS jumpers on J24 should all be off.
Speaker Enable should be on.

2.5. Connections

This section describes the steps to connect the PC host, MIB, and modem. At the end of this
procedure you should be ready to configure and use the modem. If results at any step are not as
described, consult the chapter on troubleshooting.

To connect follow these steps:

1

3.

4.

Attach the RS-232 seria cable from the host to the MIB PC Serial Port connector (J1).

The Seria Breakout Box indicators for DTR, TxD, and RTS should al light (powered from
the RS-232 connection).

Start the terminal application on the host PC. Configure the application for the port connected
tothe MIB. At thistime, the modem initially requires a setting of 19200 bps, 8 data, no
parity, 1 stop, with hardware (RTS/CTS) flow contral.

Instruct the terminal application to connect.

The DTR and RTS indicators should be green. The TxD indicator should be red.

Attach the 30-pin flat flex modem connector strap to the MIB’s SB300/SB320 port.

To make the SB300/320 connection:

i. Open the hinged SB300/SB320 connector on the MIB by lifting it away from the
edge of the board.

ii. Slidethe strap into the connector with the contact side down (coloured side up).
Besureitisfully inserted.

iii. Close the connector by pressing down on the ends of the connector rather than the
centre.

iv. Connect the 13-pin 1/O cableto the MIB and the modem. This connector is keyed
to prevent connection error.
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5. Attach the modem to the connector strap using the same procedure as the MIB end of the

connector.

-
£
e

CAUTION

Although the MIB provides support for the full SB Series of modems, it is not intended
to support more than one modem at a time. Attaching more than one modem can
damage circuitry.

Place the antenna is a suitable location, attach the antenna connector adapter to the antenna
cable, and attach the cable to the modem.

Ensure the modem power switch is OFF.

Plug the 12V DC power adapter into a 120V AC outlet and connect the power supply to the
MIB.

Switch on the MIB and modem power using the POWER switch on the MIB.

The remaining LED indicators should come on. Power indicators for 7V and 5V should show
red. The Serial Breakout Box indicators should al light; the DSR signal shows green. The
Status indicators should begin operation to specification as the modem initializes. In about 6
to 10 seconds (following the modem’ sinternal initialization) the CTS serial signal should go
green and OK should appear on the PC terminal.

10. Type AT<enter> at the host terminal. The modem should reply with OK.

The modem is now ready to be used with the host computer.

Y ou may now continue to use the modem with the terminal application, or you may close the
terminal application and use Watcher and Wirel essExpert (described below) to configure and use
the modem.

2110059 Rev 1.1
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The Operational View

3. Software Installation

3.1. Introduction

This chapter provides instructions for installing Watcher and WirelessExpert™ on a host PC and
using these programs to configure and use the modem. It also includes procedures for updating
the firmware on the modem if needed.

NOTE

Running WirelessExpert is required before using Watcher. WirelessExpert will install
and configure necessary drivers on the host PC.

Watcher

Watcher is a Windows application that configures and monitors Sierra Wireless modems for
CDPD, Circuit Switched Cellular (CSC), and Wireline operation. This chapter explains how to
install Watcher and describes basic Watcher operations and important screen elements.

WirelessExpert

Installation of the drivers required for modem operations is performed with an installation wizard
called WirelessExpert. This can be run at any time to view and edit the cellular activation settings
(NAMs, NElIs, etc.). It dlowsyou to test cellular connections.

3.2. Installing Software on the Host

The softwareis provided on CD-ROM. The CD is self-starting when inserted into a PC running
Windows 95/98/NT. An installation wizard will guide you through the process.

A menu folder is added to the Start > Programs menu:

CREET © i<

&2 Poilable PC Help

E] Finadma

15 SiemaWieles Expet

& Siernawirel el Help
i Welahoher

&5 Waichei Halp
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3.3. Configuration using WirelessExpert

WirelessExpert will automatically locate the modem on a COM port, interrogate it for features,
and install the required drivers on your host PC. It will then allow you to set or alter the cellular
activation settings.

To make the modem drivers available to the Windows operating system, the PC may be restarted
part way through the execution of WirelessExpert. Thisis done automatically but does require
that no other programs are running on the PC at the time.

Preparation:

1

2.

Ensure the host serial connection to the modem viathe MIB isin place and the modem power
ison. The full set of serial communication LED indicators should be on.

For CDPD configurations:

a. Ensurethe modem isin CDPD mode (+WS46=4). This can be queried (AT+WS467?) to
verify.

b. Ensure the modem is using the SLIP mode of service (+WS45=3). This can be queried
(AT+WS457?) to verify.

c. Ensurethe modem is set to auto-register (+WS173=1).

Close any open applications on the host PC including any communication program connected

to the modem. A system restart supervised by WirelessExpert may fail if other programs are

running. Leave the modem on.

Have the NAM / NEI and related information from your cellular service provider ready. See
Section 2.2 for information on cellular service registration.

Installation:

10.

Select Start > Programs > Watcher > WirelessExpert from the Windows taskbar.

Select the modem being used from the list:
SB320 — OR —SB300 Series for the SB300

Click Next > and then Next > again to skip the page regarding setup of other modem
products. WirelessExpert then locates the COM port connected to the modem and finds the
related registry entriesfor it. The results are displayed.

Click Next > to have WirelessExpert install the appropriate drivers for the modem.

A message may appear advising of the need to restart the computer. Click OK.
WirelessExpert shuts down the computer and restarts it for you.

When the setup wizard reappears, continue to click Next > until you pass the section on
connectivity components. WirelessExpert now examines the modem for cellular network
activation, reading any NAM and NEI entries stored on the modem.

The next page allows you to set the level of access to configuration settings that will be
allowed to the Watcher program. Setting “full access’ will allow Watcher to alter the NAM /
NEI settings, “read-only” will allow Watcher to display the settings but you will have to use
WirelessExpert or direct AT commands to alter settings.

For SB320 ingtallations, the NAM entries for CSC activation will be presented for entry and
editing. This screen isautomatically skipped for CDPD only modems.

For SB320 installations, WirelessExpert can test the connection provided you have a
registered NAM and a number to dial. Thistests that the modem can obtain a cellular channel
and place acall. The called station can be your own voice line if you simply want to verify
that the modem can reach a destination phone number. The test can be skipped by marking
the checkbox on the screen. Thistest screen is automatically skipped for CDPD only
modems.

The CDPD settings of the modem are displayed for entry and editing. A radio button sets the
active NEI for use. A pull-down menu allows setting of the channel side preference.

Page 12
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11. You are prompted to enter an IP address for a Domain Name Server (DNS). Your cellular
service provider should have provided one. This addressis used for testing the CDPD
configuration by “pinging” the provided address. It is aso added to the Windows Dial-up
Networking profile. The DNSisnot stored in the modem, it is on the host side only.

12. The CDPD settings can now be tested by WirelessExpert and will be setup in the Windows
Dial-up Networking Connection facility. A pull-down menu allows you to select the NEI to
use for the local end of the test. If you select one different from the radio button selection on
the previous screen, the new setting will become the default. This test will verify that you can
register with the CDPD network and will “ping” the DNS server to verify the connection.

The test can be skipped if desired.

13. Click Finish to complete the WirelessExpert configuration. The modem should now be ready
for use.

WirelessExpert will have created an entry in Windows Dial-up Networking for CDPD mode. You
may notice that it is configured to dial the number 2. Thisisnormal. Although CDPD
connections do not actually dial a number, Windows Dial-up Networking requires that atelephone
number be entered.

3.4. About Watcher

Watcher is a configuration and monitoring tool to manage Sierra Wireless modems. The program
can set the modem mode of operation (CDPD, CSC, or Wireline) and can be used to get
information about cellular connections and signals. Watcher can aso monitor modem connection
when using CDPD mode.

WirelessExpert must be run initialy to properly install and register the required connectivity
components with Windows. If you have not run WirelessExpert on the host PC to be used with
the modem it must be done befor e using Watcher.

3.5. Using Watcher for Modem Setup

When Watcher is started, it will check aregistry on the PC to see what mode the modem was last
used in. If it was CDPD then the program will open a CDPD connection using the settingsin the
Dial-up Networking facility of Windows which were configured by WirelessExpert. If an SB320
was last used in either CSC or Wireline mode then Watcher will attempt to set the modem to that
mode.

To start Watcher:

Select Start > Programs > Watcher > Watcher from the Windows taskbar.

Watcher will locate and initialize the modem. It will then indicate the mode and condition of the
connection.

3.5.1. Configuring Watcher

Watcher has a setup dialog that |ets you verify the Sierra Wireless modem connection to the COM
port, and the basic configuration strings Watcher will use for Circuit Switched Cellular and
Wireline operation.

To set up Watcher:

1. Make sure the modem is powered on and is communicating with your PC.

2. Select Options > Setup Watcher from the Watcher main menu
Thiswill open the Setup Watcher dialog (next page).
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“5B300 Series Connection
COM Pml:iEDMZ 'l

[ Wirelass Expert. .

“SB300 Series Configuration Strings

Entering Wireline: |al &0 |

Entering Cellular: |al &1 |

Cancel | 0OK | Help |

3. Click the WirelessExpert... button to activate the install ation wizard described above.

4. If specialized setup strings are required for your installation, you can enter them here. The
modem uses configuration strings to optimize its operation in certain modes. The modem
comes preset with the most common configuration strings. See the specific sections on CSC
and Wireline Operations for more information.

CDPD mode does not offer special setups. To control CDPD mode use Options >
Setup CDPD... described below.

5. Click OK to save the configuration and return to the Watcher program window.

3.5.2. Configuring Cellular Settings using Watcher

Watcher’s ability to manage the cellular activation settings of the modem is set by WirelessExpert.
If WirelessExpert has set the access level for Watcher to anything but full access, then Watcher
cannot be used to configure the settings.

3.5.2.1. CDPD Settings

To edit the modem configuration with Watcher:
1. Select Start > Programs > Watcher > Watcher from the Windows taskbar.

2. If the modem isnot in CDPD mode then select Settings > CDPD from Watcher’s main
menul.

3. Select Options > Setup CDPD... from the Watcher main menu.
The following window will open to allow configuration changes:

Setup CDPD

5B300 Series EID: 00-A0-D5-00-88-C2
“Active || Network Entity ldentifier Configuration
Address: Description: Unlock
NEI 10| [206.63.224 182 il
NEI 2@ |zus_33_224_133 | |
NEI 30 |u_u.u_u | |
NEI 4 O |192_u_2_2 | |

" Channel Set T SPHI Registration Sleep
C A only O A preferred || [X Enable || C Manual
. [ Enable
/B only & B preferred Setup... | (8 Automatic
CCancal | oK | Heip |

Note that the modem’s EID is displayed at the top of the window.
4. To change aNEI address you must click the Unlock button.
The Channel Set is a side preference dictated by your cellular service provider.

6. The SPNI box isused to enable the use of arestrictive list of service providers. When the
modem is finding a channel, it can determine if a channel belongs to a provider whose SPNI
isonthelist. If the SPNI isnot listed, then the modem will reject the channel and resume
searching. If thelist is enabled, use the Setup... button to maintain the list of accepted
SPNIs.

7. Registration mode allows you to select between manual and automatic registration. 1f manual
is selected, Watcher will not try to register on the CDPD network until commanded to do so.
Automatic will set Watcher to register the modem when the program is started.

o
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8. Sleep modeisdiscussed in the CDPD Operations chapter, Section . Enabling it will allow
the modem to reduce power consumption when it isinactive, but response times will be
dowed. Thisfunction setsthe sleep timer to 30 seconds.
3.5.2.2. CSC Settings

If you are using a SB320, you can place the modem in CSC mode using Watcher. The settings for
CSC can then be accessed.

To edit the modem’s CSC configuration with Watcher:
1. Select Start > Programs > Watcher > Watcher from the Windows taskbar.

2. If themodem isnot in CSC mode then select Settings > Cellular from Watcher’ smain
menul.

3. Select Options > Setup Cellular... from the Watcher main menu.
The following window will open to alow configuration changes:

Setup Cellular

SB320 ESN: 206-00057650

ber Assi Module Confi
Telephone Number: Home Spstem ID#Side: Description:

NAM 1@ | [(604)231-1100 | [65535 | [Home =] | |

NAM 20 || [[446) 4945134 | [65535 | [A pref =] | |

Active N

Cancel | (1] 4 |

Note that the modem’s ESN is displayed at the top of the window.
4. Usearadio button to select the NAM to make active.

5. Tochange aNAM entry you must delete the current value. The entry is formatted
automatically and will not allow more characters than will fit the format.

6. The Home System ID will have been provided by your cellular carrier.

7. Usethe pull-down menu to select the Side Preference dictated by your cellular service
provider.

8. The Description alows you to enter atext label to help you recognize the setting.

3.6. Monitoring CDPD With Watcher

To monitor the state of the modem’s CDPD connection, you can leave Watcher running all the
time. The connection is established through Windows Dial-up Networking and Watcher is treated
as one socket to the connection. Other Internet clients can be used simultaneously.

To monitor a CDPD connection:

1. Select Start > Programs > Watcher > Watcher — or double-click the Watcher icon.
The Watcher program window will open.

2. Ensurethe modem isregistered in CDPD mode.

3. Run other applications.

Watcher will receive event information from the modem and update the channel and signal
strength indicators (described bel ow) when the modem advises of an event. Y ou can force
Watcher to update the display by selecting Window > Refresh from the Watcher main menu or
pressing F5 when Watcher is the active window.
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3.7. About the Watcher Program Window

3.7.1.

3.7.2.

The Watcher program window |ooks like this:

-2 5B300 Series Walcher |_ (O] x]
Settings Options  Window Help
7 - (550

iCD PD: Registered [AT&T]

The window can be set to always be on top of other active windows by using the Window >
Always on Top option in the Watcher main menu. Selecting the option again will disable the
feature.

The window can be minimized and the connection monitored by use of the icon shown in the
taskbar.

Icon Status

When Watcher is minimized, the shape of the icon shown in the taskbar indicates the current
operating mode and service status.

Indicates the modem is registered in CDPD mode.

Indicates the modem is unregistered in CDPD mode.

Indicates the modem isin Circuit Switched Cellular (CSC) mode.

Indicates the modem isin Wireline mode.

Indicates the modem is not responding.

Watcher Menus and Commands

The Watcher program window contains the following menus:
Settings Options Window Help

These are described below.
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3.7.2.1. Settings Menu

Any dimmed options are not available on the modem being used.

Wireline

Cellular

CDPD

Register

Set Radio Channel...

Disable Transmitter

Exit

3.7.2.2. Options Menu

Switches the modem to Wireline mode.

Switches the modem to Circuit Switched Cellular (CSC) mode.
Switches the modem to CDPD mode.

Registers the modem on a CDPD network.

Displays options for setting the radio channel automatically or manually.

Turns the transmitter off so the modem can only receive data. When
selected a checkmark will appear beside it and the status line will indicate
the transmitter is disabled. Select the option again to re-enable the
transmitter.

Exits Watcher after gracefully shutting down any active modem connection.

Any dimmed options are not available on the modem being used.

Setup Watcher...

Setup Cellular...

Setup CDPD...

3.7.2.3.  Window Menu

Refresh F5

Always On Top

3.7.2.4. Help Menu

Displaysthe dialog box for configuring the Watcher modem
connection and the startup strings for the wireline and CSC modes of
operations. See 3.5.1 Configuring Watcher for details.

Displays adialog box for configuring Circuit Switched Cellular
mode. Y ou must be in Wireline or Circuit Switched Cellular mode to
select this command. See 3.5.2.2 CSC Settings for details

Displays adiaog box for configuring CDPD mode. Y ou must bein
CDPD mode to select this command. See 3.5.2.1 CDPD Settings for
details.

Updates the signal strength, and channel status indicators as
appropriate.
Displays the Watcher program window on top of any currently active

application window. When selected a checkmark will appear beside it.
Select the option again to disable the feature.

Pressing F1 will open the main Watcher Help window. Other accessto help features are:

Contents...

Search...

Current...

Warranty Regisrtaion..
About...

Displays the main Help topics.

Lets you search for keywordsin Help.

Opens Watcher Help to a context sensitive page.

Displays aform for automated product registration via the Internet.

Displays important information about the Watcher version; the
modem version, EID, hardware and firmware revision, transmitter
temperature, and the connectivity drivers.
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3.7.3.

3.7.4.

3.7.5.

3.7.6.

Toolbar Buttons

The Watcher program window contains three buttons for selecting the operating mode, and one
button for registering and de-registering your modem in CDPD mode. These buttons are
described below. If abutton is dimmed, the option is not available on the current modem.

l% Click to switch to Wireline mode.
Click to switch to Circuit Switched Cellular mode.
=m Click to switch to CDPD mode.

=

ﬂ Click to register the modem in CDPD mode. When the cables appear joined, the
£ modem is registered.

Click the button again to de-register the modem.

Status Indicators

O Appearsto the left of the Wireline button and indicates that Watcher is actively
communicating with the modem in a non-packet mode (Wireline or Circuit
Switched Cellular).

Appearsto the left of the Wireline button and indicates that Watcher is actively
communicating with the modem in a packet mode (CDPD).

¥ -_ Shows the Received Signa Strength Indication (RSSI). Double-click on the
gauge to display the value in dBm.

“---" (flashing)  Indicates that the modem is not locked onto a CDPD channel.
220 Displays the current radio channel.

Updating Status Indicators

The display will refresh automatically when the modem reports an event.

To force an update of the status indicators, select Window > Refresh in the main menu or press
F5 when Watcher is the active window. Depending on the operating mode, the status indicators
may take a few secondsto update.

Quitting Watcher

To quit Watcher:
1. Click the close box in the top left corner of the Watcher program window.

Watcher may take a moment to close while it gracefully closes a CDPD session and disconnects
from the modem.
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3.8. Updating Modem Firmware

Should your modem(s) require afirmware upgrade, this section describes the procedure.

See Section 1.3 Currency for information on the current revisions at the time of thiswriting. That
section also describes the method to determine the firmware revision on the modem.

Y ou can acquire updated firmware by contacting Sierra Wireless Technical Support at
604.231.1128 or by e-mail to support@sierrawireless.com. In most cases you will be provided a
URL to download the update over the Internet. Y ou may have the option to use a ZIPfile
(requiring either PKUNZIP ver 2.04g or WINZIP v5.6) or adightly larger self-extracting
executable file. Both of the ZIP utilities are available from links on the Sierra Wireless download

page.
To download the update:
1. Create afolder on your PC in which to store the download.

2. Enter the URL provided for the chosen download and save the file in the folder you have
created.

3. If the ZIP file was downloaded then Unzip it using your extraction utility.

Before updating make sure you know which COM port your modem is connected to. This
information is required by the upgrade utility.

To upgrade the Modem firmware, you can run either:
SETUP.EXE program in Windows,

INSTALL.BAT command file from DOS.

DOS firmwar e upgr ade:

1. If you run the DOS option , EXIT Windows completely.

2. Change Directory to the one with the downloaded firmware.

3. Turn off the modem.

4. Enter INSTALL <space> d whered isthe COM Port number.

Examples: INSTALL 1 (ingtalsthe firmware using COM 1)

INSTALL 3 (installs the firmware using COM 3)
5. Follow the Install instructions carefully.

Windows firmwar e upgr ade:
1. Closeall open applications.
2. Turn off the modem.

3. Runether the self extracting update file (which will expand and execute in one step) or the
SETUP.EXE file.

4. Select the COM port your modem is connected to.
5. You will be prompted to turn on the modem. When you have done so, the installation
program will automatically perform the balance of the update.

Installation provides “thermometers’ indicating the progress of the update. These are only a
guideline. Do not be surprised if the update completes before the indicators have been updated.

After the upgrade is complete you may delete the download folder or retain it for updating
additional modems, as you choose.
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There are two elements to the firmware on the modems, bootstrap and application. Not all updates
require replacement of both files. If both files do need updating, treat each update separately and
perform all steps for each. The boot firmware should be updated first.
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4. Basic Modem Operation

4.1. Introduction

This chapter provides some fundamentals to the operation of Sierra Wireless OEM modems and
some configuration elements of the host (DTE) to modem communication. Important
considerations for wireless connections are covered here but specific techniques for setting up the
modem for various remote operations are provided in chapters on each mode of operation.

This chapter covers:
Important terminology on modem modes and states.
DTE / DCE communications link.
Introduction to communication protocols and protocol stacks.
Introduction to modem-to-modem handshaking and protocols.

4.2. Modem Modes and States

The SB320 modem supports multiple modes of operation and various states within each mode.

The other OEM modems only support CDPD mode but the states and conditions apply to them as
well.

The commands and registers used depend on the modem’ s operating mode. The state of the
modem and its condition also determine how the modem will behave in any given situation.

Depending on the product, the exact options available can differ. If amode or state is not

available on the product, commands related to those modes and states will return the ERROR
result code.

4.2.1. Modes
The SB320 supports al of these modes while the SB30x family are CDPD mode only.

Wireline data — connected to the Public Switched Telephone Network (PSTN) using a cable
(usually with RJ-11 connectors). The TIP and RING signals service the wireline connection.
Wireline voice — connected to the PSTN and using the MIC and SPKR signals to convey
voice instead of data.

Circuit Switched Cellular (CSC) data — connected to a cellular network using the Advanced
Mobile Phone Service (AMPS).

Circuit Switched Cellular (CSC) voice —using the AMPS cellular network to communicate
voice instead of data.

Céellular Digital Packet Data (CDPD) — connected to a cellular packet switched data
network.

4.2.2. States

The modem’ s state, in conjunction with its condition, will govern how the modem handles traffic
to and from the host and to and from a remote modem.
All non-voice modes support two states:

Command — the modem exchanges data with the host (DTE) as AT commands and replies.
Data — communication is passed between the host and remote terminal as computer data.
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V oice modes do not support the data state. Even while off-hook and connected, the modem still
communicates with the host computer in command state. Commands can be issued and executed
while avoice connection isin progress.

4.2.3. Conditions
In addition to mode and state the modem can be in one of two conditions:

On-line — actively connected to a remote terminal, or with a network session open, or with an
active voice cal (off-hook).

Off-line — disconnected from any remote terminal, or without an active network session, or
with the “phone” on-hook.

While in off-line condition the modem can only be in command state.

In the on-line condition, the modem can be:

- In data state which passes data through the modem between the host (DTE) and the remote
terminal or network.
In command state which exchanges data between the host (DTE) and the modem (DCE)
without passing it through the active connection to the remote terminal. Voice modeis
always in command state.

4.3. Modem Communications with the Host (DTE)

Communication between the host (DTE) and the Sierra Wireless SB300 Series modemsis

currently defaulted to:
bps: 19200
Data Bits: 8
Parity: None
Stop Bits: 1

Any application being used to communicate with the modem and issue AT commands must be
configured thisway initially.

The settings can be changed for CDPD mode applications by using the +IPR (1/0O Port Rate)
command. Full auto-baud rate support will be provided in afuture firmware release.

Flow control isimplemented in hardware (RTS/ CTYS).

4.3.1. Fixed Rate Setting (+IPR)

The modem can be configured to use one specific communication rate when using CDPD maode.
The command allows any of the following settings: 300, 600, 1200, 2400, 4800, 9600, 19200,
38400, and 57600.

Data bits, parity, and stop bits remain fixed.

Once the command is issued, the modem will issue an OK at the original rate. The modem will
then perform areset and apply the new setting. The host must convert rates and monitor for the
modem’ s second OK response to establish communication at the rate.

The new setting will be retained and used across all resets and power-cycles until changed by
another +IPR command.

4.3.2. DTE Communication Options

As shipped the modem is configured with these settings:
Echo enabled (E1): which causes the modem to echo characters received from the host back
to it while in command state. The backspace is echoed as <backspace> <space>
<backspace>.
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4.3.3.

4.3.4.

4.3.5.

Quiet result codes disabled (Q0): which enables the modem to issue result codes following
commands.

Verbose result codes (V1): which provides results in English text appended with <CR><LF>.
SB320 Speaker Control is set to be on until carrier detected (M1).

This setting means that a host running a terminal emulation program for communication with the
modem should have this configuration:
Emulation—TTY
ASCII character
Sending:
No line ends with line feeds
No local character echo
Receiving:
Do not append line feeds to incoming line ends
Do not force incoming datato 7-bit.
Wrap linesif necessary

Commands may be entered in upper or lower case.

DTR Signal Handling

The modem can be configured to handle the DTR signal from the host in several ways. The AT
command &D sets the method. The factory default isto hang up any remote connection and enter
command state with auto-answer disabled (&D2).

If you experience difficulty entering command state from a data state you may wish to have the
modem reset on DTR transition.

The available options are:

&D0  Ignore DTR

&D1  Enter command state without changing on/off-line condition.

&D2  Hang up (close active session) and enter command state with auto-answer disabled.

&D3  Reset immediately (no reply isissued). (Thisisavailable on the SB320 only and not in
CDPD mode.)

DSR Signal Control

The SB300 Series modems will leave the DSR signal active whenever the modem is powered on.
Thereis no control of thissignal. Thissignal is not an indication that the modem is ready for use.
CTSis activated when the modem has completed itsinternal initialization and is ready.

Local Flow Control

The modems currently handle only hardware flow control (RTS/CTS). Thisisthe factory default
aswell. The SB320 in non-CDPD modes also supports the &K command to adjust thisin future
firmware revisions. The options are:

&KO Disable loca flow control
&K3 Use RTS/CTS hardware control

&K4  Use XON/OFF software flow control. Don't use this if these characters can be part of the
data stream.

Thereis aso an impact to flow control with the use of the Communication Mode command (& Q)
available on the SB320 in non-CDPD modes. This command effects the use of internal data
buffering at the modem. If buffering is disabled, so is flow contral.
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4.3.6.

Result Code Formats

The modems normally issue result codes on completion of an AT command. This can be disabled
with quite mode (Q1). The default isto issue results in verbose (English text) form. Numeric
codes can be selected by disabling the verbose option (VO).

If echo is enabled (E1) the modem will append a <LF> to the echoed <CR> from the host. If
echo is off, then there isno <CR> or <LF> prior to the response to the command.

Verbose result codes are returned with atrailing <CR><LF>.

Numeric result codes are returned with atrailing <CR> without the line feed.

Where the modem issues a response (data) prior to the result code, the response will have a<CR>
and <LF> appended regardless of the echo, quiet, and verbose settings.

A full diagram of the framing characters for both result codes and modem responses is provided in
the AT Command Reference (document 2110031) provided with the OEM Developer’s Toolkit.

NOTE

Allow the modem a few seconds to respond to some commands. Where mode changes
are involved the modem may require several seconds to reconfigure before responding.
On power up, following initial internal configuration, the modem will issue the OK

result code to the host whether the host is actively receiving or not.

4.4. Communication Protocols and Stacks

Data communication protocols are generally discussed in relation to the Open Systems
Interconnection (OSl) model. The OSlI model was introduced in 1978 as along-term project of
the International Organization for Standardization (1SO). It divides the communications process
into seven distinct layers, stacked one above the other, hence the term protocol stack. Thisisvery
different from the computer processing use of the term stack for a LIFO buffer.

Table 4-1: The OSI Model

L ayer

Description

Common Protocols

7 — Application

Thisisthe window between the end-user application
and the communications process. It includes functions
such aslogin and password checks, and resource
allocation.

Application programs
for file transfer,
e-mail, etc.

6 — Presentation

Responsible for terminal management such as character
set interpretation (i.e. ASCII, ANSI) and code
conversion.

5 —Session

Session management includes data-flow
synchronization, mapping addresses with names,
handling graceful and abrupt disconnections, and data
buffering. This layer organizes data into Session
Protocol Data Units (SPDUS).

Telnet, FTP, SMTP,
etc.

4 —Transport

Transport Protocol Data Units (TPDUS) are assembled
at thislayer. This can include multiplexing and
demultiplexing, error detection and recovery, and packet
reordering where the network can receive packets along
different routes which can arrive out of sequence.

UDP, TCP
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3 — Network Datais organized into packets which are data frames IP, SLIP, PPP
with network headers and trailers added including
network addressing. The duties include flow control,
handling network service data units, notifying the
transport layer of errors, and possibly sequenced

delivery.
2—Link This layer arranges the bitsinto frames. It also Network Interface
establishes and releases one or more link connections. Cards, Modems
1-Physical Thisis the physical connection layer concerned with Transmission Media:
carrying the communication of digital data. Twisted Pair, Fibre
Optics, Cellular
Radio, etc.

4.4.1. SB300 Series Internal Protocol Stacks

The SB300 Series modems are designed to provide the bottom two layers, Link and Physical. The
modem will handle acquiring a telephone line or cellular channel to provide the physical
connection.

In CDPD mode, the SB300 Series modems are a so capable of supporting the next two layers at
the user’s option. Both UDP and TCP Packet Assembly/Disassembly (PAD) services are
available along with 1P and SLIP network support. The modems do not currently support PPP but
it will beimplemented in alater firmware release.

CSC and Wireline modes require that the host system provide the protocol stack for layers 3 and
above if they are needed. Windows Dial-up Networking can provide the TCP/IP stack. Other
Windows-based Internet clients can provide the higher layersfor file transfer, e-mail, and other
services.

4.5. Modem Handshaking (SB320)

For two modems to communicate with each other, it isimperative that they speak the same
“language’, i.e. they use the same protocol(s). CDPD establishes a single protocol for its
communications, but CSC and Wireline modes can use any of several protocols. The following
discussion isfor users of CSC and Wireline modes on the SB320 modem.

Because of the variety of protocols that are available for modem communications, a modem will
usually support several protocols to enable it to connect to a variety of modems. In the process of
amodem establishing a connection with another modem, there will be a negotiation phase during
which the two modems exchange basic information to determine which protocol(s) shall be used
for the present connection.

If the modems can agree on a communication scheme using one or more of their available
protocols, they will proceed to establish a connection. At this point, the modems are ready to pass
data to their respective DTES where the application software runs. If the modems fail to agree on
a communication scheme due, for instance, to the lack of a common protocol, the connection
attempt is aborted and the modems disconnect, or go on hook.

45.1. Modem Protocol Layers

The communication protocols used by modems can be divided into three categories or layers as
shown in the figure below. Each layer operates independently of the layer aboveit. A modem

connection may be established using one or more of these layers, starting from the lowest layer
and including more layers as required by the situation.
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45.1.1.

45.1.2.

45.1.3.

Local Modem Remote Modem
Data Compression Data Compression
(V.42bis, MNP5) (V.42bis, MNP5)
Error Control Error Control
(LAPM, MNP2-4, MNP10) (LAPM, MNP2-4, MNP10)
Data Communication Data Communication
(V.34, V.32bis, V.32, ...) (V.34, V.32bis, V.32, ...)

L

Receive Data

Transmit Data

Figure 4-1: Modem Protocol Layers

Data Communication

The lowest layer isthat which is closest to the hardware and it deals with the modulation scheme
used to transmit and receive the raw data that is presented to the layer above.

This layer, which we will call the data communication protocol, has many available standards:
V.34, V.32his, V.32, V.22, etc. Itisconcerned mainly with establishing the modulation scheme
that will give the highest baud rate (bps) on a given physical point-to-point connection.

The more advanced protocols, such as V.34 for example, are smarter in that they are capable of
simultaneously supporting different rates on the transmit and receive lines, and allow two modems
to exchange information to fine-tune their modulation parameters to optimize performance.

Error Control

The next layer is the Error Control Protocol Layer which implements one of a number of error
encoding and detection schemes on outgoing and incoming data frames respectively.

By appending extra encoding bits to outgoing data packets, it allows the receiving modem using
the same Error Control protocol to check whether the data has been corrupted during transmission
and demodulation by the lower layer. Similarly, it processes data frames received from the other
modem by using the appended encoding information to check for corrupted data.

In addition to error coding and detection, this layer aso takes care of the retransmission of
corrupted packets to ensure that data delivered to the layer above it is error free.

Thislayer isaso provided in several standards: LAPM, MNP2 through 4, MNP10, etc.

Data Compression

The third layer is the Data Compression and Decompression Protocol. On outgoing data, this
layer effectively reduces (or compresses) the number of bits coming from the application layer
above it to a smaller number of bits without losing any information. The receiving modem then
decompresses this data and reconstructsiit to its original form.

Considering that the slowest link between two modems is always the wireline or cellular link, this
scheme reduces the amount of data flowing on that link and consequently increases the overall
data throughpuit.

Thislayer isimplemented by a variety of protocols, two of the most widely used ones being
V.42bis and MNP5.
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4.5.2.

45.2.1.

45.2.2.

CSC vs. Wireline

Older modem protocols, such as V.32 and earlier, were developed and optimized for PSTN
wireline networks. However, with the advent of cellular phone networks, and the need for
wireless modems to operate within these networks, it became apparent that some adjustments had
to be made to the existing protocols to enable them to achieve performance similar to their
wireline counterparts.

Enhanced Throughput Cellular (ETC®)

ETC was developed by Paradyne Corporation to bring cellular link performance up to wireline
levels. Although it does not exist as alayer of its own, it interacts with various layers by adjusting
some of their critical parameters to compensate for network differences. It uses a number of
techniques to improve the robustness of the data link.

At the lowest layer, ETC adjusts the filter characteristics that modulate and demodulate the carrier
signal to compensate for differences between PSTN and cellular networks. At the Error
Correction layer, it enforces the use of small data packets so that retransmissions are short in the
event of data corruption, which will be more frequent in a wireless environment.

Because ETC does not exist as a separate layer in the stack shown above, but instead makes use of
existing protocols, it is possible for an ETC-enabled modem to communicate with anon-ETC
modem. Although it is preferred that both sides of the modem link support ETC, one of the
attributes is that even if only one side supports ETC, significant benefits will be gained.

Also, due to the nature of ETC making use of existing protocols, ETC imposes certain constraints
on which protocols must be present at both ends for a connection to be established. The required
protocols are LAPM for Error Correction and V.42bis for Data Compression. Without these on
the receiving modem, the ETC modem will not be able to negotiate a connection and will
disconnect; irrespective of what other protocols the modems may have in common.

ETC includes the following specific settings to improve immunity to the interference and noise
effects mentioned earlier.

Small frame size

Do not alow non error-corrected links,

Wait for carrier 90 seconds

Lost carrier hang-up set to 10 seconds

Use of small frame size does reduce direct throughput by 10%, but gives a more robust
connection.

The policy of “start low and train up” guarantees that the initial negotiation phase has more
chance of success. Start-up speeds of 4800 bps and 9600 bps may be used. In addition if a
connection has not been established after 60 seconds, the modems will fall back to 1200 bps.

Even with all thisit is best to limit the maximum DCE speed.

Modulation

High speed modem protocols such as V.34 and V.32 use a technique known as Quadrature
Amplitude Modulation (QAM). QAM operates by modulating a carrier sine wave signa in both
amplitude and phase. Each unique combination of amplitude and phase is known as a‘ symbol’
and, therefore, each symbol represents a number. If there are 8 symbols (i.e. 8 unique
combinations of amplitude and phase), then each symbol corresponds to a unique 3-bit number
(Ob000 to Ob111). On the receive side, the reverse process of demodulation is performed on that
modulated carrier signal and the symbols or bits of information are retrieved.

The key to achieving high speed on a modem is to use as many symbols as possible so that more
bits can be encoded in them. The number of symbols that can be used is determined by the
receiving modem’ s ability to resolve or distinguish between these various symbols.

The more symbols there are, the more difficult it becomes for the modem to resolve them. Thisis
because there is always a certain amount of noise on the link which causes the symbols to appear
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“fuzzy” on thereceive side. The receiver can mistake one symbol for another. Thisiswherethe
protocol speed training algorithm comes into play. It is constantly measuring the amount of noise
on the line and based on that measurement will select a speed where it knows it will be ableto
resolve symbols reliably. In other words, the modem speed is a function of noise level.

Note that “noise” hereis not just noisein the traditional sense of the word, such as white noise,
crackle, etc. It aso includes distortions of the carrier signal caused by the various filtering stages
present between the two modems, starting at the transmitting modem itself, al the way through the
cellular network, the PSTN network, and finally the receiving modem.

Because cellular networks optimize their system for voice, additional distortions are created which
result in a higher noise figure and hence lower speed. ETC attempts to counteract these cellular
network distortions at both the transmit and receive ends.

The smarter protocols such as V.34 implement adaptive filtering techniques where the filter
characteristics are constantly adjusted to produce the lowest noise figure on both the transmit and
receive channels. V.32bis and lower speed protocols are not as sophisticated in that they will not
adapt to any situation. Thisiswhy aV.34 modem will achieve higher speeds than a V.32 modem
in a given environment.

The SB320 modem is capable of establishing both ETC and non-ETC connections while in CSC
datamode. The fastest protocol supported by the SB320isV.34. This meansthat the highest
speed theoretically achievable with this modem is 33600 bps. However, this occurs under idea
conditions as found typically in aPSTN wireline environment. In acellular network, experience
shows that it is quite rare for such speeds to be achieved. Instead, speeds of up to 19200 bps are
more typical, depending on the characteristics of both the cellular and the PSTN sections of the
link between two modems. Common connection rates are 9600 and 12800 bps.

The table below shows the fall back speeds from V.34 to V.22 as supported by the SB320 modem.
When ETC is enabled on the SB320 using the “super” AT command AT&F5 (described in the
CSC Operations section), the maximum speed of the modem is limited to the DTE speed (set at
19200 bps).

Protocols Speed (bps)
V.34 4800 — 33600
V.32bis 12000 — 14400
V.32 4800 — 9600
V.22bis 2400

V22 600 — 1200

Configuration Issues

Using an SB320 in Wireline or CSC modes requires careful use of the AT commands that tune the
various elements controlling the modem handshaking process. Optimizing for Wireline and CSC
modes requires different settings. Where one mode isimproved with a particular profile or
settings, the other can be impaired by the same profile.

The specific sections on CSC and Wireline Operations (Chapters 6 and 7 respectively) give a
description of some of the key AT commands and S-registers associated with performance so that
the user can modify the modem configuration from its default settings if necessary.

We highly recommend reading the Primer on CSC Data Communications (Document 2110128)
for more detailed information. Thisis available from our web site at www.sierrawirel ess.com.
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5. CDPD Operation

This section provides information on configuring and using the modem in CDPD mode if you are
not using Watcher and Windows Dial-up Networking for your connections. If you areusing a
standard Windows-based application then consult Section 3.3 Configuration using WirelessExpert.

5.1. Cellular Digital Packet Data (CDPD) Introduction

5.1.1.

CDPD isawirelessradio frequency (RF) packet switched data communications service which
provides two-way, fully digital, 19.2 kbps packet data networking services to mobile hosts. All
datais exchanged with the network in the form of IP packets (TCP or UDP). Itissimply a
wireless extension of traditional networks, providing the user with seamless access to data
applications on these networks.

Instead of using a dedicated cellular channel or telephone line to transmit data, CDPD devices,
like the Sierra Wireless modem, are able to send data over cellular voice channels (the airlink)
during the time periods when these radio channels are not used for standard cellular voice
communications. When a channel becomes overloaded or used by a cellular voice call, the CDPD
devices “hop” to an unused or idle channel. Sincethisinitial design implementation, many areas
now dedicate specific channels to only CDPD traffic.

With multiple mobile devices sharing the cellular channel, data transfer rates can vary depending
on channel loading. Maximum data rates in the order of 1000 characters per second (10 kbps) are
achievable only under lightly loaded ideal conditions.

The cellular radio channel is only used when actual datais being sent or received and not when the
user application isidle. This contrasts with CSC mode which “owns’ the connection channel as
long as the connection is open. CSC consumes the cellular resource even when the application is
not actively communicating.

CDPD prowdes the following airlink support:
Compression of packet header and information fields transmitted over the wireless channel to
reduce the amount of the airlink resource used.
Support of many users on the same cellular RF channel at the same time.
Error correction of data sent over the airlink.
Movement of the user from one cell site to another.
Delivery of properly sequenced data between user applications over the airlink.

The CDPD network operates as a collection of CDPD service provider networks, with the service
prowder networks being operated by cellular carriers who provide services such as:

Data connection to other networks

Application services

Network management

Network security

Accounting and billing

Security

With data exchanged over a broadcast radio link, security is required to prevent eavesdropping.
Airlink security is automatically provided by encrypting the data packets between the SB300
Series modem and the service provider’s Mobile Data Intermediate System (where the radio signa
isrouted to awireline public or private data network). 1f end-to-end data security is desired it
must be implemented or otherwise provided by the end-user.
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5.1.2.

5.1.3.

5.1.3.1.

5.1.3.2.

Architecture

The major cellular carriers and equipment manufacturers created a trade group called the Wireless
Data Forum (formerly the CDPD Forum), that develops and publishes the governing technical
specifications for, and promotes the use of CDPD technology.

The CDPD network provides a Connectionless Network Service (CLNS), onein which the
network routes each packet individually within the network based on the destination address
carried in the packet and knowledge of the current network topology. It is often referred to asa
datagram service. From the user’s point of view, only the destination address is known, since the
CDPD network manages the packet routing required to reach the destination.

Modem Registration

The Network Entity Identifier (NEI)

Each user on the CDPD network isidentified by a distinct Network Entity Identifier (NEI) which
is used by the CDPD network to route messages to the user. Thisislike an account on the
network.

Each NEI has a single home subdomain, where it is normally expected to be located within the
network. For example, auser’s home may be Las Vegas. Each modem may support more than
one NEI, each of which has a home subdomain, which may or may not be the same.

For example, you may wish to have three NEIs for the same modem; with these NEIs having
home subdomainsin Las Vegas, New Y ork, and Dallas (cities to which you travel regularly). You
may want to use the NEI corresponding to the city you are currently in. Alternatively, you may
want to support two separate NEIs that have the same subdomain, such as one for business use and
the other for personal use.

Y ou may travel from a subdomain registered as the home areato anew serving area. The mobility
management functions provided within the CDPD network handles the routing of packets for
visiting modems in a manner that is transparent to you. If you have pre-arranged with your service
provider, you may obtain service in a serving area supported by another service provider.

The NEI used in the Sierra Wireless modem is the address assigned to the subscriber by the CDPD
network service provider. 1P Addresses are 32-bit numbers that uniquely identify a given machine
(or end system) running the TCP/IP protocol suite. Y ou need to have a unique address before you

can link in with the rest of the networked world.

The NEI for the Sierra Wireless modem may be installed using the Wirel essExpert application
provided with the modem. Up to four unique NEIs can be supported in the Sierra Wireless
modem. The CDPD service provider will have a unique Service Provider Network Identifier
(SPNI). The CDPD service provider must supply the SPNI in numeric format to the CDPD
subscriber if you wish to restrict the modem to using that provider. The WirelessExpert
application can be used to enter SPNIs into atable of accepted providers.

Equipment Identifier (EID)

One parameter that the CDPD service providers require from the CDPD subscriber registering
their modem is the Equipment Identifier (EID). The EID is unique to each modem. Essentialy, it
represents a unique electronic serial number for the subscriber device. No two devicesin CDPD
can have the same EID.

The format used in representing this 48-bit EID is hex bytes separated by hyphens (e.g., 00-A0-
D5-00-00-7B). Thisis programmed into each Sierra Wireless modem at the factory, and the
subscriber can view the EID at any time using the Watcher or Wirel essExpert applications
supplied with the modem, or the AT command AT+WPEID.

When a user initialy signs up for service with a CDPD service provider, they will be required to
provide the service provider with the EID. This EID then becomes part of the CDPD Subscriber
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Directory Profile maintained for each subscriber on that CDPD network by the CDPD service
provider.

5.1.3.3. Authentication

Each NEI (network account) is mated to an EID (modem device). One NEI cannot be used with
different devices (EIDs). One device (EID) can have more than one associated NEI (account).

One of the functions performed by the CDPD network is NEI authentication and verification.
This service provides corroboration to ensure that the source of the data received from a user isas
claimed and not from a cloned CDPD subscriber device. In other words, only the authorized
owner of the NEI (the modem) is using the NEI. Asa result of this authentication procedure,
once a user has registered an NEI and a modem, they cannot use that NEI for data
communication over the CDPD network on a new or different modem.

If you replace or change modems, you must contact your service provider to reset your network
credentials before you can use the new modem.

5.1.4. CDPD Radio Coverage

The subscriber should obtain information from the service provider about what CDPD service
coverage is available in the required areas.

In most cases, the subscriber will not be aware of the quality of service provided over the CDPD
airlink. Watcher does provide afeature that gives the user an indication of the airlink quality for
their Sierra Wireless modem. This quality metric is based on the strength of the signal that is
being received by the modem.

Received Signal Strength Indication (RSSI) is a measure of the strength of the RF signal received
by the modem. It is expressed either by an analogue thermometer or alogarithmic scale, in
decibels relative to one milliWatt (dBm). A strong signal level has aless negative number (i.e.,
-60 dBm) and aweak signal level has a more negative number (i.e., -100 dBm). Connections are
lost for signals below -113 dBm.

The CDPD service provider attempts to ensure that the signal level isfairly strong throughout the
coverage area (i.e., -80 dBm or stronger), but due to shielding of the signal by man-made
structures, the signal may be less than this desired value.

Examples of locations where asignal could be weaker than desired is in underground parking
garages, tunnels, buildings with all metal construction, old concrete buildings with large amounts
of steel reinforcing bars, etc. 1n such cases, the CDPD subscriber may be able to get a stronger
signal by locating the antenna near an opening or window. The effect of this repositioning on the
RSSI can be observed in the signal strength window of the Watcher application.

5.1.5. CDPD and the SB300 Series Modems

Therole of the Sierra Wireless modem in CDPD mode is:

6. Accept commands and digital data from the end-user application equipment (DTE) through
the serial connection.

7. Assemble the datainto packets.

8. Encrypt the packets.

9. Transmit the encrypted data packet to the network.

10. Receive packet data from the network.

11. Decrypt the packets.

12. Disassemble the packets to extract the application data.

13. Passthe serial datato the end-user’s application equipment.
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Note that the built-in encryption is for the airlink only (between the modem and the cellular
service base station). If end-to-end data security is desired it must be implemented or otherwise
provided by the end-user.

The extent to which the packet datais assembled and disassembled by the modem is determined
by setting the CDPD packet service mode to use SLIP, UDP, or TCP. Use of these protocolsis
discussed later in this section.

5.2. Configuring NEI Entries

5.2.1.

In order for the modem to register on a CDPD network it must have a unique Network Entity
Identifier (NEI). Thisisan Internet Protocol (IP) address assigned by your CDPD network service
provider. Section 2.2.1 CDPD Registration contains information on activating this service.

The service provider must assign you an NEI and channel side preference. They should also
provide their Service Provider Network Identifier (SPNI) number. To do this, the service provider
will need to know the Equipment Identifier (EID) of the modem, which can be reported by the
modem by issuing the +WPEID command.

Thisinformation is recorded within the modem either by using the WirelessExpert configuration
program or through direct entry using AT commands. To use WirelessExpert please consult
Section 3.3.

If you need to access web sites on the Internet, a Domain Name Server (DNS) addressis also
required. The modem does not manage this layer of the Internet connection but WirelessExpert
will record the DNS address in the Windows networking facility for use at the application level.

NEI Table

The modem can store up to four NEIs. One of these isthe active NEI entry. The active entry is
the one on which most NEI related commands act. It can be different from the auto-register NEI
or acurrently registered NEI. The active NEI isindicated by an index pointer stored in register
+WS197.

Although it is recommended, it is not necessary to de-register from the CDPD network before
making changes to the table. If you alter the NEI entry that is currently registered, the modem will
de-register the old value. If auto-register is enabled, the modem will then attempt to register the
new one.

NOTE

CDPD credentials are directly associated to the table entries. You cannot re-arrange
the NEIs in the table without resetting credentials with your cellular service provider.

52.1.1.

NEI Configuration With AT Commands

To store the NEI and related CDPD activation parameters using AT Commands enter the
following commands (the AT is omitted for brevity):

1. +WPNEILIST to display the NEI table and indicate if oneisregistered. The auto-register
NEI isindicated with an asterisk (*) but the active NEI is not indicated.

2. +WS197=n where n isthe entry you wish to edit (1 through 4). Thiswill make it the active
NEI.

3. +WPNEI=ip whereip isthe NEI addressto assign. Y ou do not need leading Osin the
individual elements of the address. When you press <enter> the modem will respond with a
prompt to confirm the change in the table. The old and new values are both shown.

PressY (caseinsensitive) to confirm the change, or
Press N (or any key other than Y) to cancel the command.
The modem will respond with OK if the NEI isin avalid IP form.
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4. +WPNEILIST to display the list and verify the new entry.

5. +WS174=n where n indicates the channel side preference. Vaues are:
0— A side preferred,
1-B side preferred,
2—A sideonly,
3—B sideonly.

NOTE

The channel side preference is stored in a register not associated with a particular
entry in the NEI table. The preference will be used for all NEI registrations.

5.2.2.

SPNI Matching

If you want to restrict the modem to only using channels belonging to a particular list of service
providers you can enter atable of SPNI values. When the modem is finding a channel, it will
check the SPNI of each channel against entriesin thistable. If thereis no match, the modem will
reject the channel and continue searching.

If the table is empty, the SPNI matching feature is disabled.

NOTE

If you set SPNI matching and also use +WPCHAN to assign a channel manually, the
assigned channel will not lock if the SPNI failsto match. The modem will not be able
to register because it will not look for another channdl if you have manually set a
channel. The status of channel lock can be checked using +WPRSSI.

5.2.2.1.

SPNI Table Configuration

To manage the use of SPNI matching using AT Commands enter the following commands (the
AT is omitted for brevity):

Read the Current SPNI Table

1. +WPSPNI? Displaysthe SPNI Table. If the table is empty then SPNI matching is disabled.
If thereis at least one entry then SPNI matching is enabled.

Disable SPNI Matching

1. +WPSPNI= By not entering parameters, the table will be erased. An empty table disables
SPNI matching.

Enable SPNI Matching

1. +WPSPNI=n[,n[,...n]] wheren isaSPNI value and multiple values are separated by
commas. Thelist of parameters provided will replace any previous table. Y ou cannot append
entries to an existing table. Y ou may enter up to 10 valuesin the table. By entering one or
more SPNI values, the SPNI matching feature is automatically enabled.

5.3. CDPD Network Registration

Note that network registration must be performed before communication across the network can
begin. Registering on the network is distinct from opening a session. Registration simply
confirms a connection to the network as a whole and authenticates your modem’ s credentials.
Data Carrier Detect (DCD) istied to sessions not network registration. A session does not begin
until you originate a session (client) or answer one (server).

The modem can be set to register manually (on command) or automatically when it enters CDPD
mode. The NEI address used for registration is determined differently for each method.
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5.3.1.

5.3.2.

5.3.2.1.

The mode of registration is set in register +WS173 (Registration Mode). A value of 0 indicates
manual registration and 1 indicates automatic. The modem is shipped with avalue of 1 but the
modem will always default to the last method used. Restoring settings with &F (factory) or

Z (user profile) will NOT restore a setting to this register.

For WirelessExpert to work, the modem must be set to automatic registration.

Active and Auto-register NEI Indices

The modem keeps two separate index entries to the NEI table. These indices have an intricate
inter-relationship that you should understand.

Auto-registration uses the index at +WS176 (Auto-register NEI Index). Manual registration and
manipulation of the NEI table are based on an index at +WS197 (Active NEI Index).

When the modem registers an NEI, the index of the NEI used (manually or automatically) will be
stored in the Auto-register NEI Index (+WS176). This means that auto-registration will always
use the last registered NEI unless the Auto-register NEI Index is changed while the modem is de-
registered in manual (+WS173=0) mode.

Changing the setting in the Auto-register NEI Index while the modem is registered causes the
modem to de-register the old NEI address. This happens in both manual and auto-register modes.
If the modem is set to auto-register (+WS173=1) then the modem will go on to attempt to register
the new NEI.

Register +WS197 (Active NEI Index) is quite independent of any currently registered NEI and
can be changed freely. This allows access to other table entries while registered without affecting
the registration status.

The manual registration command (+WPREG) will use the Active NEI Index (+WS197) asthe
addressto register. It will aso store the value of the Active NEI Index (+WS197) into the Auto-
register NEI Index (+WS176) so that it becomes the default address for future auto-registration.

This copying of the index takes place even if the manual registration fails.

In summary, the Auto-register NEI Index value will follow the Active NEI Index value if thereis
an attempt to register manually. The Active NEI Index can change freely and is not influenced by
changes in the Auto-register NEI Index.

Manual Registration

When the modem is set for manual registration (+WS173=0) it will not attempt to locate a CDPD
channel until commanded to register (+WPREG) or the command to set a channel (+WPCHAN)
isset to O (automatic selection). You may select a channel first if desired. If you do not assign a
channel, or if you force automatic channel selection by setting +WPCHAN=0, the modem will
scan for one when the registration command is issued.

Select a Channel

If you assign a channel, the modem will use that channel for registration attempts. If registration
fails on the assigned channel NO automatic attempts are made to locate another channel.

NOTE

If you set SPNI matching and also use +WPCHAN to assign a channel manually, the
assigned channel will not lock if the SPNI failsto match. The modem will not be able
to register because it will not look for another channel if you have manually set a
channel. The status of channel lock can be checked using +WPRSSI.
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5.3.2.2.

5.3.3.

5.3.4.

Assign a Channel

To assign a channel for use by the modem issue the AT command +WPCHAN=n where n isthe
channel number to assign. The modem will go to that channel. Subsequent use of +WPRSSI will
report the strength of signal and if the channel has been acquired (locked).

Changing the channel assignment while the modem is registered will not change the registration
status. The modem may lose connectivity if the new channel does not present sufficient signal or
fails to meet other requirements such as SPNI matching.

Where the cellular carrier forces CDPD channel hopping (part of the CDPD specification) the
modem will follow the hops regardless of the user assigned channel.

Auto-locate a Channel

To have the modem locate a channel, issue the AT command +WPCHAN=0. The modem will
then scan for a channel when requested to register (or auto-register). RSSI requests will reflect the
status of the channel found. The channel number will also be available by querying register
+WS200 (Current Channel Number).

Register Manually

To register an NEI manually:
1. +WS197=n where n isthe index to the NEI you wish to register.

2. +WPREG to register the NEI. If the NEI isaready currently registered the modem takes no
action and returns the registration result code. Otherwise, the modem will:
De-register any currently registered NEI
L ocate a channel if necessary
Attempt to register the NEI and authenticate credentials

The modem will terminate the process on one of three conditions:
Success — The modem will report the Registered result code.
Failure—The CDPD network failed to register the NEI for reasons given in the result code
(i.e. INSUFFICIENT_CREDENTIALYS).
Time-out — The register +WS198 (Registration Wait Time) allows settings from 1 to 255
seconds (default 30) for the registration process. If thistime elapses without successful
registration the modem will return the Timeout Expired result code.

Automatic Registration

The modem can be set to register the NEI indexed by +WS176 (Auto-register NEI Index)
automatically. Register +WS173 (Registration Mode) controls this feature. When thisregister is
set to 1 the modem will immediately attempt to register and will subsequently attempt to register
automatically on entry to CDPD mode (startup on CDPD only modems).

Automatic registration will retry indefinitely should attempts fail.

Setting the Registration Mode to O will de-register the current NEI if it successfully auto-
registered earlier.

De-registration

The modem will de-register on any of several events.

If the modem isin manual registration mode it will de-register if:

- The De-register command (+WPDEREG) isissued for the registered NEI. Note that this
command will reference the NEI indexed by register +WS197 (Active NEI Index). Itis
possible that this register has been changed (by command) after an NEI was registered and no
longer points to the registered entry; in which case, the registered NEI remains registered and
no action is taken by the modem. The Active NEI Index must point to the registered address
for this command to work.

Theregistered NEI is overwritten with a new value using +WPNEI=ip.
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If the modem isin automatic registration mode it will de-register if:
The registration method is changed to manua (+WS173=0).
The value of the Auto-register NEI Index (+WS176) is changed.
Theregistered NEI is overwritten with a new value using +WPNEI=ip.

5.4. Monitoring the Network Connection

5.4.1.

54.1.1.

54.1.2.

54.1.3.

54.1.4.

5.4.2.

54.2.1.

Prior to finding a channel, many query itemswill return 0. Once locked onto a CDPD channel, the
modem can provide several pieces of information about the connection. Additional information is
available regarding the registration of the modem.

Radio Signal Monitors

Signal Strength

There are two primary monitors of signal strength.

A “percentage” value can be read from register +WS50 (Normalized Signal Strength). It reportsa
value from 0 to 100 where 0 isimperceptible and 100 is full signal.

The Receive Signal Strength Indication (RSSI) is more informative. It isread with the RSSI and
Channel State command (+WPRSSI). It reports:

Signal strength in dBm (-113 to -30),

State of the channel (1 - Scanning, 3 - Acquired, 4 - Sleeping),

Registration Status (0 no, 1 yes)

Channel number (0 if scanning)

Note that the registration status reported here is that of the Active NEI Index (+WS197) which
may point to a NEI other than onethat isin fact registered. Consult register +WS56 to check the
registration status of the modem.

Current Channel

The channel number is available from register +WS200. A value of 0 indicates the modem has
not acquired a channel.

SPNI of the Connected Carrier

When the modem has locked onto a channel (whether registered or not) the Service Provider
Network Identifier (SPNI) for that channel can be read with the command +WCID.

Cell Number

Although not important in most circumstances, the number of the current CDPD base station is
available from register +WS210.

Registration Status

The status of the modem’ s registration can be read at register +WS56 (Network Registration
Status). A value of 1 indicates the modem isregistered. A value of O indicatesthat it is not
registered.

Registration Mode

The current setting of auto-registration isfound in register +WS173. A value of 1 indicates
automatic registration is enabled, 0 indicates manual registration mode.

Page 36

Proprietary and Confidential 2110059 Rev 1.1



User’'s Guide

CDPD Operation

5.4.3.

5.4.3.1.

Note that it is possible to read a value of 1 indicating auto-registration is enabled while, in fact, the
modem is not registered and is not attempting to register. It is possible to detect situations where
this has happened by also reading the Registration Result Code (+WS201). If theresult codeis
254 — Unregistered by user — then the modem will not automatically attempt to register.

This situation arises when one of these events occur:
Manually commanded to de-register (+WPDEREG).
Manually commanded to hang-up and de-register (H1).
\SHDN input signal has been activated.

Manual registration can till be used while auto-registration is inactive, unless the \SHDN signal
remains active (low).

The modem will resume auto-registration attempts when one of these events occur:
Modem reset (soft or hard) or power-cycle
Command to force auto-registration to enabled state (+WS173=1)
CDPD modeis re-entered (on the SB320 only)

PING

PING is a utility to test connections across an |P network. PINGs are packets of data with special
flags in the header which advise the protocol stack at the receiving end to echo the packet back.
The sender typically times the duration from transmission to echo receipt to determine the speed
of the network link. The application at the receiving end of a PING has no knowledge of the
transaction. It handled within Layer 3 of the protocol stack.

When the modem is registered, you can issue PINGs to the modem and it should reply. If you are
using a SLIP connection, the stack on the host will be responsible for repliesto PINGs. If you use
either the UDP or TCP packet servicesin the SB300 Series modem, then the modem will handle
the PING without the host’s knowledge.

Obtaining a PING from the Modem

A detailed discussion of this process follows the outline of steps to test the modem’sreply to a
PING. (AT is omitted for brevity):

1. +WS46=4 to place the modem in CDPD mode (only required on the SB320).
2. +WS45=0 or 1 to select UDP or TCP packet service.

3. Optionaly assign a channel with +WPCHAN=n where n is the channel to use.
4

Optionally verify the channel acquisition with +WPRSSI looking for the second valuein the
return string to be 3.

If the modem is using auto-registration (+WS173=1) skipto step 7.

5. +WS197=n where n isthe index (1-4) of the NEI to register, to select the NEI

6. +WPREG to register on the CDPD network. The modem will reply as noted in the section
above on manual registration.

7. +WS56? to query the registration status. Repeat this command until it returns a value of
1 (registered) or until the host chooses to timeout, failing the connection.

8. Using a network-connected PC, open a MS-DOS Prompt window.

9. Atthe MS-DOS command line enter:
PING <ip> where <ip> is the address of the modem. Do not use leading zeros in the IP
address components (there is a bug in the PC service).
The modem should reply and the PC will indicate the echo time. Four PINGs are issued by
this command option.

If the requests timeout without success, try alowing alonger wait time by adding the parameter
—w 2000. That will allow 2 seconds (2000 ms) for the echo before the PC will time out the
attempt. For afull list of PING command options, enter the command PING without parameters.
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5.5. Sleep Mode

5.5.1.

CDPD provides afacility to allow modems to go to “sleep” when they do not have active traffic
with the network. This allows the modems to shut down hardware to reduce power consumption.

When the modem is waiting for data from either the host or the network, it does not need to keep
all hardware systems running. The modem can negotiate with the CDPD network to have the
network send a periodic message advising if there is pending traffic. Between these messages, the
modem can be programmed to shut down the receiver (go to sleep). The modem will wake up at
the predetermined intervals to check the network for incoming traffic. If thereis no pending
traffic, then the receiver can go back to sleep until the next scheduled notification message.

The SB300 Series modems can use this feature and have added an additional feature called “logic
deep” and “logic deep sleep” to further reduce power consumption. Each of these leep modesis
described below.

CDPD Sleep

Thisiswhat is meant by the general term “sleep” mode. CDPD deep is controlled by setting
register +WS175 (CDPD Sleep Idle Time).

Setting the register to 0 (zero) will disable sleep mode. The modem will keep the receiver active
for immediate handling of any incoming traffic from the network or host.

Sleep is enabled by setting the register to the time in seconds, from 10 to 3600 (1 hour), during
which the modem must not have network traffic. Provided there is no traffic to or from the
network during that interval, the modem will begin using CDPD sleep.

NOTE

For CDPD dleep to engage, the modem must have negotiated with the network to allow
itsuse. This means that the setting of the enabling register (+WS175) must have been
done prior to network registration. 1f the modem has already registered with the
network, changing the setting of the CDPD Seep Idle Time will have no effect until the
modem is de-registered and re-registered.

5.5.2.

The CDPD network advises the modem of the time interval between periodic notification
messages. Thisistypically 60 to 90 seconds. Y ou should verify with your carrier what interval is
used.

Once sleep mode is engaged, the modem logic will turn off the radio receiver. It will turn on the
receiver at the intervals prescribed by the network to check for traffic. If thereistraffic, the
modem will then receiveit. Should the network require a CDPD channel hop while the modem is
dleeping, the modem will have to scan for the new channel when it wakes for the next periodic
check. Thisis handled automatically.

The disadvantage to sleep mode is that traffic from the network will have to wait up to a
maximum of one interval for the next notification cycle before the modem can receiveit. This
delay in responding can be too great for some time critical applications. This delay also appliesto
“ping” packets sent to a sleeping modem.

While sleeping, the modem logic is still active and ready to receive data from the host at any time.
The modem will immediately wake up the radio for host generated traffic going out to the
network. Thereisno delay in sending messages, only in receiving network packets.

Logic Sleep

In addition to switching off the radio for CDPD deep, the modem can be placed in alogic sleep
mode. This further reduces the power consumption of the modem. Logic sleep will not engage
unless CDPD dleep is aready engaged.
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If logic deep isenabled (S31 > 0), it will automatically engage on the next CDPD sleep mode
interval. Logic seep continues until dataor an AT command is received from the host, or the
modem must perform the periodic CDPD sleep mode check. After performing the periodic
network check, and provided there is ho pending AT command or traffic from the host, the modem
will resume both CDPD and logic sleep.

The modem can use logic deep while in auto-answer mode. The modem logic must wake-up
periodically as part of the CDPD sleep operation to check the network for messages. Incoming
data from the network amounts to a RING when auto-answer is enabled, so the modem logic will
be awake to receive messages.

Thisfeature is controlled with register S31 (Logic Sleep). Setting the register to O (zero) will
disablelogic deep. Setting it to 1 will enable normal logic sleep. In this condition the modem
will reduce power until the host sends a command or CDPD slegp operation requires activity. It
will wake as soon as a character arrives from the host, or automatically as needed to make periodic
network checks for traffic.

Logic Deep Sleep

Setting the Logic Sleep register to 2 will enable deep-sleep. Thiswill cause the modem to shut
down even more hardware, conserving even more power. The disadvantage to thisisthat the
modem will lose the first incoming character(s) from the host (DTE). In fact, the modem will take
80 milliseconds, from the start of the first incoming character, to wake up. The host should send a
“dummy” character first, which the modem will lose, and then wait the 80ms delay before sending
the complete command or data string. Automatic wake-ups to check the network will still occur
SO0 ho incoming network traffic islost.

5.6. Friends Only

Friends Only is a feature available when either the UDP or TCP PAD is enabled in a server
session, but is not used with the SLIP protocol.

Friends Only permits reception of packets to be restricted (for security reasons) to a predefined
group of 1P addresses (friends). Friends Only mode is controlled by entering IP addressesin a
Friend Only table. If the tableis not empty, the feature is enabled and the comparison of packet
source addresses against the list stored in the modem will be made.

This subject is discussed in further detail in both the UDP and TCP packet services sections
below.

5.7. Dial Directory

A supplemental application of the Friends Only list isto “quick dial” client sessions to addresses
onthelist. Thelist supports the entry of a port number along with each IP. The port number is
ignored by server sessions when testing incoming packets but is used for quick dialling.

The Dial command (D) supports use of a digit parameter (1 — 10) in place of an explicit IP and
port. The number isthe index to an entry in the Friends Only list. Provided the entry contains a
valid IP and port, the modem will dial that destination to connect a client session.

5.8. Packet Services

SB300 Series modems support three connection protocols in CDPD:
SLIP
UDP PAD
TCP PAD

PPP service is not yet implemented but will be included in afuture firmware release.
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5.8.1.

5.8.1.1.

The modem’ s packet serviceis set in register +WS45 (Packet Service). This setting can be made
before or after registration on the network. It should not be changed once the modem starts a
session (ison-line). If achange to packet service is required, the user must close the current
session (go off-line), change the setting, and then establish a new session.

Use of each of the servicesis described in sub-sections below. For more on protocols generally
see Section 4.4 above.

Serial Line Interface Protocol (SLIP)

SLIP is one method for encapsul ating packet data over dedicated and/or switched seria lines. Itis
auseful and reliable way to allow mixes of hosts and routers to communicate with one another in
various combinations.

When operating in SLIP mode, the modem’ sinternal Packet Assembly / Disassembly (PAD)
services are bypassed and the modem acts as a router passing data between the host’ s protocol
stack, and the CDPD network. All protocol headers are the responsibility of the host asisthe
SLIP framing to the packets. The modem will parse the SLIP frame character to distinguish
packets and to identify the data state escape sequence.

This protocol is useful if the host application must have multiple sessions active concurrently. An
example would be a police car, which may need simultaneous connectionsto alocal dispatcher, a
state motor vehicle bureau, and a federal database.

Note that the SLIP protocol does NOT support auto-answer. If the modem was in auto-answer in
another packet service, it will be turned off (S0=0) when SLIP is selected. Attemptsto set the
auto-answer register (S0) to avalue other than O will return the ERROR result code.

Opening a SLIP Client Session

A detailed discussion of a SLIP session follows the outline below of the steps to open a SLIP
Client Session. (AT is omitted for brevity):

1. +WS46=4 to place the modem in CDPD mode (only required on the SB320).
2. +WS45=3 to select SLIP service.

3. Optionaly assign a channel with +WPCHAN=n where n is the channel to use.
4

Optionally verify the channel acquisition with +WPRSSI looking for the second value in the
return string to be 3.

If the modem is using auto-registration (+WS173=1) skipto step 7.

5. +WS197=n where n isthe index (1-4) of the NEI to use for this registration.

6. +WPREG to register on the CDPD network. The modem will reply as noted in the section
above on manual registration.

7. +WS56? to query the registration status. Repeat this command until it returns a value of
1 (registered) or until the host chooses to timeout, failing the network connection.

8. O to dtart the session. The modem will reply with CONNECT at which point you are in data
state.

The modem is now ready to pass host packets to the network. Any incoming packets, from any
originator, will be passed to the host. This allows the host to send and receive packets to multiple
destinations asynchronously provided the host can manage multiple socket connections.

Detailed Discussion

The first two steps smply place the modem in CDPD SLIP mode. The modem’ s session state is
set in register +WS45 (Packet Service) by step 2. Setting this value to 3 will place the modem in
SLIP mode. This can be done before or after registration on the network so auto-registration can
occur before this step.
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5.8.1.2.

The registration process can be more closely controlled with steps 3 through 6. Steps 3 and 4 can
be used in auto-register as well as manual register configurations.

To send data over the network in SLIP mode the user must enter a data state connection to the
network. Thereisno explicit destination in SLIP mode so the Dial command is not supported.
You are better advised to verify the modem has registered and smply go on-line. Registration is
verified with aresponse of 1 to the query of register +WS56.

If there are problems with registration, the host should manage a timeout on this process.
Continue to repeat the +WS567? query until you get aresponse of 1 (registered) or the host timer
expires.

The O command will switch the modem to data state regardless of the registration condition. This
should only be used if you know the modem has successfully registered on the CDPD network.

Once in data state, the modem acts as a pipe through which data passes. All PAD and IP protocol
stacks as well as SLIP framing must be implemented on the host (DTE) system. Windows Dial-up
Networking can provide these services.

Transmitting

Data packets received from the host (DTE) are forwarded to the network in 128 byte segments.
They can be buffered on the modem up to 14 segments (1792 bytes). Beyond this, thereislocal
hardware flow control (RTS/CTS) with the host to prevent overflow.

Receiving

Incoming data from the network is buffered (up to 14 x 128 bytes) and is passed to the host as it
arrives. If the modem has been placed in command state but is still in on-line condition, incoming
datawill be buffered. There is an automatic remote flow control between the modem and the
network to prevent overflow.

Escaping Data State

To escape data state in SLIP mode, the host can issue the escape sequence <OxCO0>+++<0xC0>
to the modem. The hexadecimal value OxCO is the SLIP frame character. This means the modem
will be sent a frame containing nothing but the escape code (+++). Thisis parsed by the modem
as an escape and it will not forward the packet to the network.

Entering the OxCO character from the keyboard is accomplished one of two ways: using the
numeric keypad to enter Alt+0192, or using Character Map, a Windows accessory program.

The modem will enter command state but remain registered and in on-line condition (the session is
kept open). If data arrives at the modem while the session is open and the modem is in command
state, the datais buffered as described above.

An alternative to the escape sequence isto pre-set the DTR Options (&D) to either 1 or 2 and then
switch DTR off to escape data state. If the option isset to 1 (&D1), the modem will enter
command state the same asiif the escape sequence was issued; it will remain registered with the
current session still open. If the DTR Option is 2 (&D2) then the modem will close the session,
de-register, and return to command state. Note that if auto-registration is enabled, the modem will
switch off DCD (closing the current session) but will remain registered.

If the session has been kept open, the host can re-enter data state by issuing the On-line command
(O). The modem will respond with CONNECT and data state is restored.

Closing a SLIP Session

To end a SLIP session, escape data state as described above. If the &D2 DTR option is used then
the session is closed.

If the escape sequence or the &D1 DTR option is used then you must hang-up with either HO or
H1 to close the session. Both of these will close the current session. If the modem is set to
manual registration, it will also be de-registered by both of these commands.
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5.8.2.1.

H1 will force de-registration of the modem even if auto-registration is enabled. The modem will
remain de-registered. Although auto-registration remains enabled, the modem will not resume
auto-registration until the register isreset (+WS173=1) or the modem itself re-enters CDPD mode
(amodem reset or power cycle on CDPD-only modems).

User Datagram Protocol (UDP)

UDP isthe most basic transport protocol provided by the modem. It is athin protocol, adding
only a port specification to the underlying Internet Protocol (1P). It has the same features as [P,
that is a best effort, connectionless delivery service, with the chief benefit being minimum
overhead.

UDP is not considered reliable because packet delivery is not guaranteed. Packets can be lost,
duplicated, delayed, or delivered out of sequence. These conditions are not detected, and the
sender or receiver is not informed.

UDP is connectionless because sender and receiver are never logically connected. If the intended
receiver is not active and available the messageislost. It isabest effort delivery, because the [P
software makes an earnest attempt to deliver the packets, failing only if system resources are
overloaded or the underlying networks fail.

Application programs using UDP must accept full responsibility for handling the problems of
reliability, including message loss, duplication, delay, out-of-order delivery, and loss of
connectivity.

These problems are often treated casually by programmers. Testing done when using highly
reliable, low delay local networks may not expose potential failures. This explains why many
applications that use UDP work well in aloca environment but often fail in dramatic ways on a
more global network.

Opening a UDP Client Session

Client sessions are those in which your modem initiates a conversation with a server.

A detailed discussion of thistype of session follows the outline of steps to open a UDP Client
Session. (AT is omitted for brevity):

+WS46=4 to place the modem in CDPD mode (only required on the SB320).
+WS45=0 to select UDP packet service.

Optionally assign a channel with +WPCHAN=n where n is the channel to use.

Optionally verify the channel acquisition with +WPRSSI looking for the second value in the
return string to be 3.

A wbhpE

If the modem is using auto-registration (+WS173=1) skip to step 7.

5. +WS197=n where n isthe index (1-4) of the NEI to register, to select the NEI

6. +WPREG to register on the CDPD network. The modem will reply as noted in the section
above on manual registration.

7. +WS56? to query the registration status. Repeat this command until it returns a value of
1 (registered) or until the host chooses to timeout, failing the connection.

8. D<dest> where <dest> isthe destination |P and port number to send your datato. If the
Dial Directory (quick dial) is being used, <dest> can be an index to the Friends Only list.
The entry there will be used to determine the IP address and port for the call. Seethe AT
Command Reference for details on this command.

The modem will reply with CONNECT at which point you are in data state.

The modem is now ready to accept host data for packet assembly and transmission to the network.
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Any incoming packets, from a remote originator other than the <dest> will be ignored. Incoming
packets from the <dest> address will be passed to the host. This alows the host to exchange data
with a specific station.

Detailed Discussion

Thefirst two steps smply place the modem in CDPD UDP mode. The modem’s packet service is
set in register +WS45 (Packet Service) by step 2. Setting this value to 0 will enable the modem’s
UDP stack. This can be done before or after registration on the network so auto-registration can
occur before this step.

The registration process can be more closely controlled with steps 3 through 6. Steps 3 and 4 can
be used in auto-register as well as manual register settings.

To send data over the network in a UDP client session the user must enter a data state connection
to the network with a specific |P address and port number. The On-line command (O) can be used
with the modem using the default 1P address and port. Unfortunately, thereis no way for you to
verify what this destination is, so we recommend you issue the dial command with an explicit
destination each time you start a client session.

The IP of the destination can be any valid IP. Client sessions do not apply the Friends Only
restrictions. If the Dial command is given bad syntax including an invalid destination IP or port
number, then it will return the ERROR result code. Thisisalsotrueif a“quick dia” index points
to an empty or invalid entry in the Friends Only list.

The Dial command can handle the network registration process using the NEI indexed by the auto-
register index. Seethe AT Command Reference for details. This means steps 3 through 6 can be
omitted if desired.

The response to the Dial command will depend on the setting of register +WS179 (Registration
Wait Status). If the setting is O (the default) then the CONNECT code is returned regardless of
the success or failure of the modem to register. 1f the modem was not registered then the dial
command must perform the task. The UPD PAD isready and you may start assembling datainto
a packet while the registration process proceeds in parallel. The modem will buffer the data until
the modem registers. A failureto register isNOT reported to the host, and the packet can be lost.

If the Registration Wait Status register is set to 1, then the modem will not respond to the dial
command until the registration process terminates. In this case, the response can be one of the
following:

CONNECT The modem must have successfully registered and you can
communicate with the network.

NO CARRIER The modem failed to register with the network within the time allowed
by +WS198.

ERROR Aninvalid IP or port number was specified or there was some other

error in the Dial command syntax.

It isimportant to understand that CONNECT does not mean that you have established a
communication link with the destination. UDP is*connectionless’, meaning that you only have a
connection to the network. Data packets are not guaranteed to reach their destination using UDP.

Transmitting

Once in data state, the modem uses its PAD management services to assembl e the data coming
from the host into packets. See Section 5.9 for a discussion of these services.

Receiving

When the connection is established actively (by aD (Dial) or O (On-line) command), the modem
treats the connection as a client session. Incoming packets are accepted from the destination
address specified in the Dial command (or defaulted in the On-line command) regardless of
whether or not it is contained in the Friends list.

Any packets arriving from an I P other than that in the Dial command are ignored.
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5.8.2.3.

If the modem has been placed in command state but is still in on-line condition, incoming data
will be buffered. Thereisan automatic remote flow control between the modem and the network
to prevent overflow.

Escaping Data State

There are two methods to escape data state in UDP packet service. The host can issue the PAD
Time Independent Escape Sequence (TIES) if it is enabled, or the DTR Option can be used if it is
enabled.

TIES

This method is enabled with register +WS60=1 (the default). It is disabled with a setting of O
(zero). When enabled, the host can send the TIES string (AT+++) within apacket. The“AT”
portion must be in uppercase. The complete sequence must fit within the current packet. If the
maximum packet length boundary is reached in the middle of the TIES string, then that part of the
string in the packet will be forwarded and not included in TIES checking.

Note that any partial packet assembly prior to reception of the TIES will belost. To ensure datais
properly forwarded, the Primary Forwarding Character should be sent prior to sending the TIES
string.

The TIES sequence must be terminated with the Primary Forwarding Character (+WS64), which
isusually the carriage return <CR>. If the Forwarding Character Feature Mask (+WS63=0) is set
to O (zero) then TIES is also disabled, regardless of the setting in +WS60. See Section 5.9 for
additional details on packet management and notes regarding the PAD Inter-Character Timer’s
impact on TIES entry.

When the TIES is received by the modem, it will enter command state but remain registered and in
on-line condition (the session is kept open). If data arrives at the modem while the session is open
and the modem isin command state, the datais buffered as described above. See below for
instructions on closing the session.

If the session has been kept open, the host can re-enter data state by issuing the On-line
command (O). The modem will respond with CONNECT and data state is restored.

DTR Option

An dternativeto TIESisto pre-set the DTR Options (&D) to either 1 or 2 and then switch DTR
off to escape data state. If the option isset to 1 (&D1), the modem will enter command state and
remain registered with the current session still open. If the DTR Option is 2 (&D2) then the
modem will close the session, de-register, and return to command state. Note that if auto-
registration is enabled, the modem will switch off DCD (closing the current session) but will
remain registered.

If the session has been kept open, the host can re-enter data state by issuing the On-line
command (O). The modem will respond with CONNECT and data state is restored.

Closing a UDP Session

To end a UDP session, escape data state as described above. If the &D2 DTR option is used then
the session is closed.

If TIES or the &D1 DTR option is used then you must hang-up with either ATHO or ATH1 to
close the session. Both options of the Hook Control (H) command will close the current session.
If the modem is set to manual registration, it will also be de-registered by both of these options.

ATH1 will force de-registration of the modem even if auto-registration is enabled. The modem
will remain de-registered. Although auto-registration remains enabled, the modem will not
resume auto-registration until the register is reset (+WS173=1) or the modem itself re-enters
CDPD mode (a modem reset or power cycle on CDPD-only modems).
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NOTE

Thereisa PAD Inactivity Timeout in register S30 that can also close a session. This
timer is disabled by default (set to 0) but can be set to a value from 1 to 20 minutes to
prevent the modem from holding an idle session open. If this mechanism closes the
session the modem will send the message “ OK” to the host and return to command
state. The Carrier Detect (DCD) signal will also go inactive indicating the session is
closed.

5.8.2.4.

Opening a UDP Server Session

Server sessions are those in which your modem answers a“call” from another system. The
modem is enabled or disabled from handling server sessions by the setting in +WS212 (Listening
Port). A setting of O disables the modem from answering server requests. Setting the register to a
valid port will enable the server side of the protocol stack.

Answering server connection requests is handled independently from enabling the service.
Provided the service is enabled, the modem can be configured to auto-answer or leave answering
up to the host with a manual answer command. Register SO controls the answering scheme. A
setting of O disables auto-answer and will require the host to issue the Answer — Manual (A)
command. Setting the register to 1 will enable auto-answer and the modem will automatically
switch to data state for incoming server session requests.

A detailed discussion of this type of session follows the outline of steps to open a UDP Server
Session. (AT is omitted for brevity):

1. +WS46=4 to place the modem in CDPD mode (only required on the SB320).

2. +WS45=0 to select UDP packet service.

3. Optionaly assign a channel with +WPCHAN=n where n is the channel to use.

4

Optionally verify the channel acquisition with +WPRSSI looking for the second value in the
return string to be 3.

If the modem is using auto-registration (+WS173=1) skip to step 7.

5. +WS197=n where n isthe index (1-4) of the NEI to register, to select the NEI

6. +WPREG to register on the CDPD network. The modem will reply as noted in the section
above on manual registration.

7. +WS56? to query the registration status. Repeat this command until it returns a value of
1 (registered) or until the host chooses to timeout, failing the connection.

8. +WS212=<port> where <port> isthe port number (1025-4999) that the modem will listen
to. The modem will only accept packets addressed to this port. The factory default is 2100.

9. Optionaly set SO=1 to enable auto-answer mode.

The modem will remain in command state until a message is received from the network. The
session is not actually opened until the first acceptable packet is received.

In server sessions the modem will check all incoming packets for the source |P address. If Friends
Only isenabled, the originator’s IP address is checked against entriesin the Friends List. If no
match is found the packet is discarded. If thereisamatch, or the Friends List is empty, the
modem will also verify that the destination port is matched to the listening port set in register
+WS212.

Provided an incoming packet is acceptable, the modem will then toggle the RI signal and issue the
RING message to the host. The RI signal istoggled on for one second and off for four seconds. If
the DTR signal isinactive, the toggle isissued atotal of three times for each connection attempt.
The RING message is sent to the host once only regardless of the state of DTR.
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If auto-answer is enabled, the modem will then open the session. If DTR is off (indicating the
host is unavailable), the packet is buffered. At thistime, thereisno DTR flow control. Any
incoming packets received while DTR is off are held in the modem buffers until one arrives at a
timewhen DTRison. At that point, all buffered packets are forwarded to the host.

If auto-answer is disabled, the modem will buffer the packet and wait for the host to issue the
Answer — Manua (A) command.

Upon opening the session, the modem will issue the CONNECT <ip> message (where <ip> isthe
address of the calling station) to the host to indicate the transition from command state into data
state. The CONNECT message providesa“caler ID”. Note that quiet mode (Q) will suppress
the word CONNECT but not the IP caller id.

The incoming packet is then presented to the host and the modem is ready to accept host reply data
for packet assembly and transmission to the network.

NOTE

Packets are buffered at the modem. If manual answer is being used, and several
connection attempts are ignored, the packet buffers may overflow. When a sessionis
opened, all buffered packets are forwarded to the host.

It is possible to have buffered packets from multiple source clients but only the last
packet received can be answered.

The onus is on the user to implement host protocols when using UDP to ensure data is
not lost or corrupted.

Detailed Discussion

The first two steps smply place the modem in CDPD UDP mode. The modem’s packet service is
set in register +WS45 (Packet Service) by step 2. Setting this value to 0 will enable the modem’s
UDP stack. This can be done before or after registration on the network so auto-registration can
occur before this step.

The registration process can be more closely controlled with steps 3 through 6. Steps 3 and 4 can
be used in auto-register as well as manual register settings.

The listening port (+WS212) must be set to the desired port number to communicate over. Both
the client and server must share this port number.

In aserver session, the host does not originate transmissions, but rather waits for service requests
from acalling client. The modem does not enter data state until the first packet is received.

Receiving

Incoming packets are accepted from the network only if the IP of the sender is on the Friends List
or thelist is empty (Friends Only disabled) and the destination port matches the listening port set
inregister +WS212. Any packets arriving from an I P other than those accepted are ignored.

When a packet arrives, the IP address and port of the sender is stored as the address to send
packetsto. See Transmitting for additional details and issues on this.

If the modem has been placed in command state but is still in on-line condition, incoming data
will be buffered. Thereisan automatic remote flow control between the modem and the network
to prevent overflow.

Transmitting

Once in data state, the modem uses its PAD management services to assembl e the data coming
from the host into packets. See Section 5.9 for a discussion of these services.
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NOTE — Reply Addressing in UDP Server Sessions

The source address (1P address and port number) of the last accepted packet is saved
in atemporary variable for use as the current destination address for all packets being
sent by the modem during the current server session.

This can lead to some conflict on busy systems. If a packet arrives from source A and
is currently being serviced by the host when a packet arrives from source B, a reply
intended for A will be sent to B.

A future firmware revision will implement a BUSY response which will avoid this
problem. For now, this situation cannot be avoided in UDP server sessions. The only
remedy isto use the TCP PAD to establish distinct point-to-point communication links.

5.8.2.5.

5.8.2.6.

5.8.2.7.

The host will only know the identity of the calling station from the “caller ID” provided in the
CONNECT message. Once in data state the incoming packets could be from any acceptable
station (based on Friends Only activation) and matching the listening port.

The normal behaviour would have the server receive a message, issue areply, and then close the
session. Auto-answer will be re-enabled so the client can send another packet if needed which
will appear to the host as a new session with “caller ID”.

An aternative would have all clients use an agreed protocol in which the client includes station
identification data within the packet. It isthe user’sresponsibility to supply this level of protocol.

Escaping Data State

Escaping a UDP server session is handled exactly the same way as a client session. See
Section 5.8.2.2 above for details.

Closing a UDP Server Session

Closing a server session is handled exactly the same way as a client session. See Section 5.8.2.3
above for details.

Provided the modem is set to auto-register and H1 is not used to close the session, the modem is
ready for the next UDP server session without further configuration. Auto-answer will remain
enabled and the modem registered on the network.

To disable auto-answer, you must set register SO=0. Thiswill prevent the modem from starting
any further server sessions.

UDP Broadcast and Multicast

These services are not yet supported by the SB300 Series modems but are planned for future
firmware upgrades.

Broadcast and multicast are CDPD functions that support sending the same data to alarge group
of IP Addresses with asingle transmission to the CDPD network. This capability isimplemented
through Mobile Data I ntermediate System (MDIS) software. Check with your carrier to determine
if these capabilities are offered before planning to use it as part of your application.

Broadcast and multicast transmissions are point-to-multi-point and provide a one-way UDP
connectionless service. The operational considerations are:
Protocol restrictions prevent broadcast or multicast messages from being encrypted.
Broadcast or multicast data packets will not be received by a SB300 Series modem with an
active TCP PAD session.
If aUDP PAD session is active the broadcast and multicast messages will be interspersed
with the application data packets and must be separated by the application.
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In the case of SLIP, the disposition of the broadcast and multicast messages is a function of
the support provided by the software stack and end-user applications (one must be UDP)
operating on the Mobile Application Subsystem (MAS). If aUDP session is not active, the
messages will be lost.

Broadcast

The Broadcast function is used on a geographic coverage basis. To support this function the
MDIS s set up with a Broadcast NEI that includes alist of the Mobile Data Base Stations
(MDBSs) in the desired broadcast areain its definition. There can be multiple broadcast areas
within the coverage area of asingle MDIS. A message is transmitted to a Broadcast NEI at the
MDIS that replicates the message, puts a special broadcast header on it, and sendsit to the cells
indicated by the broadcast list.

For most applications broadcast is not appropriate, because broadcast messages are sent to all the
CDPD modems in the covered geography. It is more useful to be able to specify that messages
only go to all, or a subset of the IP Addresses associated with a specific customer; a capability
offered by multicast.

Multicast

Multicast is set up similarly to broadcast, except that the MDIS is set up with a Multicast NEI and
alist of the terminals that belong to that specific group rather than alist of cells, as used by the
broadcast function. The message to be multicast is sent to the Multicast NEI at the MDIS, which
replicates the message and sends individual messages to the terminals indicated in its multicast
group list.

A termina can be amember of any number of multicast groups, however it can only be activein
one at any giventime. A terminal wishing to receive multicast messages indicates its readiness by
registering a Multicast NEI and by being ready to receive UDP datagrams. The latter can be
accomplished by having the UDP Server function set to active, or if in SLIP mode, by having a
UDP application set to ready. In all of the preceding cases the MAS is assumed to be ready to
process any incoming multicast datagrams.

Contact the service provider for information on the availability and use of multicast servicein
your area.

Transmission Control Protocol (TCP)

Transmission Control Protocol (TCP) is an advanced transmission protocol that adds substantial
functionality to the underlying Internet Protocol it is built on. Because of this structure it is often
referred to as TCP/IP. The advantage of TCP is reliability of data transmission; achieved by using
positive acknowledgements with retransmission if required. The main disadvantage isthe
overhead needed to provide thisreliability under various conditions.

Due to the positive acknowledgements used in TCP, it is not recommended that sleep modes be
enabled in the modem. If the modem goesto sleep, the possible delays in sending and picking up
acknowledgements can result in excessive re-transmissions and even lost connections.

Unlike UDP, TCP offers both reliable and connected data transmission service. Lost, delayed,
duplicated, or out of sequence packets are detected and automatically corrected. A logical point-
to-point connection is established and maintained throughout the communications session. It
requires very little other than session establishment, sending data over the serial port, and session
termination to get a basic application operational .

The price for thisreiability is the number of extra data packets used and the time required to
process them. Both need to be considered when selecting an application protocol.
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5.8.3.1. Configuring a TCP Client Session

Client sessions are those in which your modem initiates a conversation with a server.

A detailed discussion of this type of session follows the outline of steps to open a TCP Client
Session. (AT is omitted for brevity):

1. +WS46=4 to place the modem in CDPD mode (only required on the SB320).
2. +S31=0 to disable logic Seep.

3. +WS175=0 to disable CDPD deep.

4. +WS45=1 to select TCP packet service.

5. Optionaly assign a channel with +WPCHAN=n where n is the channel to use.
6

Optionally verify the channel acquisition with +WPRSSI looking for the second value in the
return string to be 3.

If the modem is using auto-registration (+WS173=1) skip to step 9.

7. +WS197=n where n isthe index (1-4) of the NEI to register, to select the NEI

8. +WPREG to register on the CDPD network. The modem will reply as noted in the section
above on manual registration.

9. +WSb56? to query the registration status. Repeat this command until it returns a value of
1 (registered) or until the host chooses to timeout, failing the connection.

10. D<dest> where <dest> isthe destination |P and port number to send your datato. If the
Dial Directory (quick dial) is being used, <dest> can be an index to the Friends Only list.
The entry there will be used to determine the IP address and port for the call. Seethe AT
Command Reference for details on this command.

The modem will reply with CONNECT at which point you are in data state.

The modem is now ready to accept host data for packet assembly and transmission to the network.

Incoming packets from the <dest> address will be passed to the host. This allows the host to
exchange data in a point-to-point connection on a specified port with a specific station.

Detailed Discussion

Thefirst four steps simply place the modem in CDPD TCP mode. The modem’s sleep features
are disabled to prevent delays in TCP acknowledgements, which would cause excessive re-
transmissions and possibly loss of connection. The modem’s packet service is set in register
+WS45 (Packet Service) by step 4. Setting this value to 1 will enable the modem’s TCP stack.
This can be done before or after registration on the network so auto-registration can occur before
this step.

The registration process can be more closely controlled with steps 5 through 8. Steps 5 and 6 can
be used in auto-register as well as manual register settings.

To send data over the network in a TCP client session the user must enter a data state connection
to the network with a specific |P address and port number.

The On-line command (O) can only be used after a session has started. The Dial command must
be used to establish the TCP point-to-point connection. Once established, the host can escape data
state and then use this command to return to data state with the point-to-point connection still
intact.

The IP of the destination can be any valid IP. Client sessions do not apply the Friends Only
restrictions. If the Dial command is given bad syntax including an invalid destination IP or port
number, then it will return the ERROR result code. Thisisalsotrueif a“quick dial” index points
to an empty or invalid entry in the Friends Only list.
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5.8.3.2.

The Dial command can handle the network registration process using the NEI indexed by the auto-
register index. See the AT Command Reference for details. This means steps 3 through 6 can be
omitted if desired.

Note that two timers are used for the connection process. +WS198 (Registration Wait Time) is
used to timeout the network registration process. The default is 30 seconds. A second timer at S7
(TCP PAD Timeout) is used to time the TCP connection handshake. Thistimer defaultsto 30
seconds aswell. The TCP PAD Timeout starts when the Dial command isissued. If modem was
not already registered, then network registration will consume time from thistimer aswell. In
other words, the TCP PAD Timeout can run concurrently with the Registration Wait Timer.

The response to the Dial command when TCP is enabled does not depend on the setting of register
+WS179 (Registration Wait Status). The CONNECT codeis only returned on the successful
network registration and TCP negotiation with the destination. A failure to register or negotiate
TCPisreported to the host by either aNO CARRIER or NO ANSWER result code. The
response can be one of the following:

CONNECT The modem has successfully registered and established the TCP
connection. 'Y ou can now communicate with your destination.

NO CARRIER The modem failed to register with the network within the time allowed
by +WS198.

NO ANSWER The modem could register with the network but could not negotiate the
TCP handshake with your destination within the time allowed by
register S7.

ERROR Aninvalid IP or port number was specified or there was some other
error in the Dial command syntax.

PAD ERROR An internal modem error has occurred in the TCP stack. The modem

will have to be reset.

Unlike UDP, a CONNECT message in TCP service does mean that you have established a
communication link with the destination.

Transmitting

Once in data state, the modem uses its PAD management services to assembl e the data coming
from the host into packets. See Section 5.9 for a discussion of these services.

Receiving

Incoming packets are accepted from the destination address specified in the Dial command
regardless of whether or not it is contained in the Friends list.
Any packets arriving from an I P other than that in the Dial command are ignored.

If the modem has been placed in command state but is still in on-line condition, incoming data
will be buffered. Thereisan automatic remote flow control between the modem and the network
to prevent overflow.

Escaping Data State

There are two methods to escape data state in TCP packet service. The host can issue the PAD
Time Independent Escape Sequence (TIES) if it is enabled, or the DTR Option can be used if it is
enabled.

TIES
This method is enabled with register +WS60=1 (the default). It is disabled with a setting of O
(zero).

When enabled, the host can send AT+++ asa packet. The“AT” portion must be in uppercase.
See Section 5.9 for details on packet management and notes regarding the PAD Inter-Character
Timer.
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When the TIES is received by the modem, it will enter command state but remain registered and in
on-line condition (the session is kept open). If data arrives at the modem while the session is open
and the modem isin command state, the datais buffered as described above. See below for
instructions on closing the session.

If the session has been kept open, the host can re-enter data state by issuing the On-line command
(O). The modem will respond with CONNECT and data state is restored.

DTR Option

An dternativeto TIESisto pre-set the DTR Options (&D) to either 1 or 2 and then switch DTR
off to escape data state. If the option isset to 1 (&D1), the modem will enter command state and
remain registered with the current session still open. If the DTR Option is 2 (&D2) then the
modem will close the session, de-register, and return to command state. Note that if auto-
registration is enabled, the modem will switch off DCD (closing the current session) but will
remain registered.

If the session has been kept open, the host can re-enter data state by issuing the On-line command
(O). The modem will respond with CONNECT and data state is restored.

5.8.3.3. Closing a TCP Session

To end a TCP session, escape data state as described above. If the &D2 DTR option is used then
the session is closed.

If TIES or the &D1 DTR option is used then you must hang-up with either ATHO or ATH1 to
close the session. Both of these command options will close the current session. If the modem is
set to manual registration, it will also be de-registered by both of these options.

ATH1 will force de-registration of the modem even if auto-registration is enabled. The modem
will remain de-registered. Although auto-registration remains enabled, the modem will not
resume auto-registration until the register is reset (+WS173=1) or the modem itself re-enters
CDPD mode (a modem reset or power cycle on CDPD-only modems).

NOTE

Thereisa PAD Inactivity Timeout in register S30 that can also close a session. This
timer is disabled by default (set to 0) but can be set to a value from 1 to 20 minutes to
prevent the modem from holding an idle session open. If this mechanism closes the
session the modem will send the message NO CARRIER and return to command state.
The Carrier Detect (DCD) signal will also go inactive indicating the session is closed.

5.8.3.4. Opening a TCP Server Session

Server sessions are those in which your modem answers a“call” from another system. The
modem is enabled or disabled from handling server sessions by the setting in +WS212 (Listening
Port). A setting of O disables the modem from answering server requests. Setting the register to a
valid port will enable the server side of the protocol stack.

Answering server connection regquests is handled independently from enabling the service.
Provided the service is enabled, the modem can be configured to auto-answer or leave answering
up to the host with a manual answer command. Register SO controls the answering scheme. A
setting of O disables auto-answer and will require the host to issue the Answer — Manual (A)
command. Setting the register to 1 will enable auto-answer and the modem will automatically
switch to data state for incoming server session requests.

A detailed discussion of thistype of session follows the outline of steps to open a TCP Server
Session. (AT is omitted for brevity):

1. +WS46=4 to place the modem in CDPD mode (only required on the SB320).

2. +S31=0 to disable logic seep.

3. +WS175=0 to disable CDPD deep.
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4. +WS45=1 to select TCP packet service.
Optionally assign a channel with +WPCHAN=n where n is the channel to use.

6. Optionaly verify the channel acquisition with +WPRSSI looking for the second value in the
return string to be 3.

o

If the modem is using auto-registration (+WS173=1) skip to step 9.

7. +WS197=n where n isthe index (1-4) of the NEI to register, to select the NEI

8. +WPREG to register on the CDPD network. The modem will reply as noted in the section
above on manual registration.

9. +WSb56? to query the registration status. Repeat this command until it returns a value of
1 (registered) or until the host chooses to timeout, failing the connection.

10. +WS212=<port> where <port> isthe port number (1025-4999) that the modem will listen
to. The modem will only accept packets addressed to this port. The factory default is 2100.

11. Optionally set SO=1 to enable auto-answer mode.

The modem will remain in command state until a TCP handshake is completed with a calling
client.

The session is not actually opened until a TCP connection handshake is negotiated with an
accepted 1P address on the listening port. 1n server sessions the modem will check all incoming
packets for the source IP address. If Friends Only is enabled, the originator’s IP addressis
checked against entriesin the Friends List. 1f no match is found the handshake will fail and the
host will not be advised of any activity. Thisis handled entirely within the modem.

Provided connection request is acceptable, the modem will then toggle the Rl signal and issue the
RING message to the host. The RI signal istoggled on for one second and off for four seconds. If
the DTR signal isinactive, the toggle isissued atotal of three times for each connection attempt.
The RING message is sent to the host once only regardless of the state of DTR.

If auto-answer is enabled, the modem will then open the session. If DTR is off (indicating the
host is unavailable), incoming packets are buffered. At thistime, thereisno DTR flow control.
Any incoming packets received while DTR is off are held in the modem buffers until one arrives
at atimewhen DTRison. At that point, all buffered packets are forwarded to the host.

If auto-answer is disabled, the modem will wait for the host to issue the Answer — Manual (A)
command before completing the TCP connection handshake. If the host is slow to answer, the
caller may timeout (get aNO ANSWER result).

Once the session is opened the host is notified with the CONNECT <ip> message (where <ip> is
the address of the client station). The CONNECT message provides a“caller ID”. Note that
quiet mode (Q) will suppress the word CONNECT but not the IP caller id.

At this point the modem changes from command state to data state. Incoming packets are then
presented to the host and the modem is ready to accept host reply data for packet assembly and
transmission to the client.

Detailed Discussion

Thefirst four steps simply place the modem in CDPD TCP mode. The modem’s sleep features
are disabled to prevent delays in TCP acknowledgements, which would cause excessive re-
transmissions and possibly loss of connection. The modem’s packet service is set in register
+WS45 (Packet Service) by step 4. Setting this value to 1 will enable the modem’s TCP stack.
This can be done before or after registration on the network so auto-registration can occur before
this step.

The registration process can be more closely controlled with steps 5 through 8. Steps 5 and 6 can
be used in auto-register as well as manual register settings.

The network registration is verified by testing register +WS56. Once registered the modem is
configured to receive calls.
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5.8.3.5.

5.8.3.6.

The listening port (+WS212) must be set to the desired port number to communicate over. Both
the client and server must share this port number.

In aserver session, the host does not originate transmissions, but rather waits for service requests
from acalling client. The modem does not enter data state until a successful TCP handshake has
been negotiated.

Receiving

Incoming requests for TCP connection are accepted from the network only if the IP of the sender
ison the Friends List or the list is empty (Friends Only disabled) and the destination port matches
the listening port. Any connection requests or packets arriving from an IP other than those
accepted are ignored.

Once the session has been started, the modem will only receive packets from the connected client
IP. Thiswill remain in effect until the session is closed.

If the modem has been placed in command state but is still in on-line condition, incoming data
will be buffered. Thereisan automatic remote flow control between the modem and the network
to prevent overflow.

Transmitting

Once in data state, the modem uses its PAD management services to assembl e the data coming
from the host into packets. See Section 5.9 for a discussion of these services.

All outgoing packets are directed to the connected client IP until the connection is closed.

Escaping Data State

Escaping data state to allow the issuing of AT commands to the modem is handled exactly the
same way asaclient session. See Section 5.8.3.2 above for details.

Closing a TCP Server Session

Closing a server session can be handled in three ways.

- The server host can close the session exactly the same way as aclient session. See
Section 5.8.3.3 above for details.
The client can disconnect. The server host will receive the“NO CARRIER” message and the
Carrier Detect (DCD) signal will go inactive indicating the session has closed.
The modem can close the session if the PAD Inactivity Timeout in register S30 expires. This
timer is disabled by default (set to 0) but can be set to a value from 1 to 20 minutes to prevent
the modem from holding an idle session open. If this mechanism closes the session the
modem will send the message “NO CARRIER” and return to command state. The Carrier
Detect (DCD) signal will aso go inactive indicating the session is closed.

Provided the modem is set to auto-register and ATH1 is not used to close the session, the modem
isready for the next server session without further configuration. Auto-answer will remain
enabled and the modem registered on the network.

To disable auto-answer, you must set register SO=0. Thiswill prevent the modem from opening
any further server sessions.
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5.9. Packet Assembly Management

Once in data state with either the UDP or TCP PAD enabled, the modem accepts data from the
host (DTE) and assemblesit into packets. Packet assembly is largely transparent to the host but
some assembly management features are available.

Starting a Packet

A packet is started when the host starts sending data to the modem. The modem will buffer the
data as it assembles the packet.

Real Time Data Entry and Editing

The modem can echo characters from the host back to it is cases where aterminal application is
being used to allow individuals to type and send messagesin real time. Thisis similar to Internet
Relay Chat (IRC). Setting +WS62=1 will enable the echo (the default) and setting +WS62=0
will disableit.

If this type of communication is being used, the modem can also optionally allow editing of the
packet buffer. Setting +WS72=1 (the default) will enable local editing of the data beforeit is
forwarded to the network. This alows you to backspace using the character set in +WS73 (the
default is8 <BS>). If local echo is aso enabled then the modem will echo the backspace
character, a space, and another backspace.

Forwarding a Packet

The modem closes and sends a packet when one of the following events occur:

1. The maximum packet length set in +WS74 (default 1000) is reached. Y ou may wish to set
this value smaller if you are encountering too many packet errors and retransmissions. Setting
it below 5 will preclude use of the TIES to exit data mode. See below for details.

2. The modem receives the PAD Primary Forwarding Character set in register +WS64. This
character defaults to 13, the carriage return <CR>. The feature is enabled by default and can
be controlled with a bit mask option set in register +WS63. The options are:

0 Disabled

1 The packet isterminated and the forwarding character is discarded.

3 Theforwarding character isincluded in the packet before the packet is closed and sent.
The default option setting is 3.

3. ThePAD Inter-Character Timer (+WS70) expires. Thistimer isdisabled (set to 0) by
default. It can be set to values from 0.1 to 25.5 seconds. If particularly short times are used,
real time typing will be forwarded virtually asit isreceived. Thiswould aso mean that
manually typing the TIES to escape data mode is virtually impossible as the packet is closed
before the full character string is entered.

NOTE: If you disable the primary forwarding character (+WS63=0) and the timer (+WS70=0),
the only way to forward packets will be to fill the packet buffer. Thisisvery strongly
discouraged.

Using TIES

The Time Independent Escape Sequence (TIES) is a method to shift the modem from data state to
command state. It is enabled by setting +WS60=1 (the default) and disabled by setting
+WS60=0.

The escape sequence is a packet containing only the string “AT+++" wherethe “AT” must bein
uppercase. To ensure the packet contains only this value you must be sure that you are starting a
new packet and that the modem will not close the packet before the string is compl ete.

To ensure you are starting a packet, you must ensure that one of the forwarding events described
above has occurred. The easiest way isto send the Primary Forwarding Character.
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To ensure that you can enter the complete string, you cannot set the maximum packet length less
than 5. Y ou must also provide sufficient time in the PAD Inter-Character Timer to enter each
character. If thisisto be manually typed, the value should be set quite high (or disabled
altogether). You must also avoid setting the PAD Primary Forwarding Character (+WS64) to one
of the three charactersin the TIES string (A=65 ,T=84 ,+=43).

5.10. Data and Telemetry Applications

If you are communicating data files or telemetry using one of the modem’s PAD services (UDP or
TCP) that do not involve direct human interaction, you should make appropriate changes to the
packet management features of the modem.

Exact settings will depend on the nature of your application and the quality of your network
connection. What follows are some issues to consider.

If binary datais being communicated, you should disable the PAD Primary Forwarding Character
feature (+WS63=0) and use the PAD Inter-Character Timer (+WS70=5) instead. This will
prevent unusually small packets where the forwarding character might occur frequently in the
binary data. It will also ensure datais forwarded to the network within aroughly known period.
This allows the server to detect if problems have occurred at the client end.

The maximum packet length (+WS74) should be set as best suits the size of the data or telemetry
filesyou are sending. Remember that, in areas of poor network connectivity where
retransmissions are frequent, overall throughput may be improved by using smaller packet sizes.

Specific modem configuration samples for particular case studies may be available soon from the
Sierra Wireless Internet site at www.sierrawireless.com.
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6. CSC Operation

This section provides information on configuring and using the SB320 modem in Circuit Switched
Cdlular (CSC) data mode if you are not using Watcher and Windows Dial-up Networking for
your connections. If you are using a standard Windows-based application then consult Section 3.3
Configuration using WirelessExpert.

The introduction provides some background on CSC communicationsin general.
For details on CSC Voice operation see Section 8 Voice Operation in CSC and Wireline.

6.1. Introduction

6.1.1.

6.1.1.1.

6.1.1.2.

6.1.2.

Circuit Switched Cellular is awireless mode of communication in which the datalink connection
between the SB320 modem and the remote modem is made over the circuit switched voice cellular
network. Thisvoice cellular network is based on the Advanced Mobile Phone Service (AMPS).

Data communications are carried on over thislink as if a standard landline telephone connection is
being used. Circuit Switched Cellular is perhaps the most familiar form of wireless data and voice
communications. This mode works like normal wireline communication except that the modem
link is over acellular phone call rather than alandline phone call. Like cellular phones, cellular
modems have their own telephone number and require a dedicated channel for the duration of the
call.

Modem Registration

Cellular Phone Number

Using the modem over the cellular network requires that the modem be assigned a Number
Assignment Module (NAM). Thisis essentially the phone number associated with your modem.
Thisis assigned to you when you register your modem with a cellular carrier. The cellular carrier
requires the unique Electronic Serial Number (ESN) which is assigned to your modem at the
factory.

The unit is capable of retaining two NAMs, with each NAM being independently assigned to any
cellular service provider.

Aswith your credit card number, bank machine number, or any other private password, you
should safeguard the NAM and keep it private.

Calls made with the Sierra Wireless modem using CSC maode are not possible until the NAM has
been programmed. The NAM data consists of the cellular phone number as well as other
subscriber and cellular service provider information.

Electronic Serial Number (ESN)

The Sierra Wireless modem stores the ESN internally. Y ou can display it through the Watcher
application by choosing Help > About from the main menu when the modem is operating in
Circuit Switched Cellular mode. Y ou can also display the ESN by using the AT+WVESN
command. The ESN is displayed in text form for both NAMs.

CSC Radio Coverage

Because the cellular radio channel is an inherently noisy channel (unlike the public switched
telephone network), the remote modem to which the Sierra Wireless modem places a call should
as a minimum, support the V.42 error correction standard. Thiswill correct the errorsin data
transmission that occur over the radio channel.
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6.1.3.

These errors result from various forms of electrical interference, noise generated by other cellular
subscribers (especially during peak usage periods), and the user being located in areas of poor
cellular coverage such as remote locations or inside buildings. The use of any cellular device
inside a building suffers from varying degrees of signal loss due to losses in the building walls and
office materials inside the building. Better signals can be achieved by locating the modem near a
window or other opening and by ensuring that the modem antenna is deployed in the vertical
position.

Within any cellular network, there will be regions of poor signal coverage. In these areas, noise
will affect communications. In addition, an effect known as co-channel interference can be heard
on the cellular channel. Thisisinterference from acellular phone in a different cell. These effects
will sporadically limit the communications link, leading to momentary loss of data, or a dropped
call.

Modem Pools

Asdiscussed in Section 4.5.2 above, there are significant performance differences between
configuration profiles for cellular modems and landline modems. To help alleviate this, some
cellular carriers offer modem pools for cellular data calls.

Modem pools were devel oped to overcome the need to have a“cellularly aware” modem at the
landline side of a cellular datalink. The end to end link actually consists of two back to back
modem connections. The cellular modem initiates a connection with the cell-side modem in a
pool, while at the same time the land-side modem in the pool initiates a connection with the
destination landline modem. The two modems within the modem pool pass data between
themselves using a buffered digital link. The cell-side modem typically supports the necessary
features to ensure a robust modem link.

To use amodem pool for acal, involves prefixing the called phone number with *DATA
(*3282).

Although benefits are generally gained by using modem pools, there are a few disadvantages to
this configuration:
Cadll initiation time is long, and there can be long delaysin end to end character echo.
Calls to mobile modems cannot be made through a modem pool.
Configuration is unique from base-station to base-station, it is not always optimized.

Section 6.5 below provides information for advanced users on optimizing the modem for
particular environments.

6.2. Configuring the Modem for CSC

Y ou can configure the settings using either WirelessExpert or Watcher as described in Section 3.3
and 3.5.2. Alternatively you can enter the configuration using AT commands as described in the
following sub-sections.

6.2.1. Setting the NAM

See Section 2.2.2 for information on registering for CSC cellular service. Make sure your carrier
givesyou a 10-digit NAM (area code plus phone number), Home System ID, and aside
preference (A or B).
1. +WS46=7 to ensure the modem isin CSC mode.
2. +WS178=n where n isthe entry you wish to edit (1 or 2). Thiswill make it the active NAM.
3. +tWPNAM? to display the current entry and verify that it can be changed.
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4. +WPNAM=num,sys,pref where num isthe 10 digit phone number with area code and
without brackets, spaces, or dashes (i.e. 6042311100); sys isthe Host System ID provided by
your cellular service provider; and pref isthe numeric code for the side preference as shown
below:

0—A side preferred,
1-B side preferred,
2—A sideonly,
3—B sideonly,
4 —Home only.

When you press <enter> the modem will update the entry and respond OK. If the responseis
ERROR then a parameter was out of range or the syntax was incorrect.

5. +WPNAM? to display the new entry and verify it is correct.
The NAM isnow set and is active. If you wish to enter an alternate NAM then repeat the process

from step 2. The active NAM used by the modem for CSC connections will be the one indexed by
the +WS178 register when you are finished.

6.2.2. Confirm CSC Service

To ensure that your modem can make a cellular call:

1. +WS46=7 to ensure the modem isin CSC mode.

2. +WS178=n where n isthe NAM entry you wish to use. Thiswill make it the active NAM.
3. +WPNAM? to display the current entry and verify that it is the one to be used.
4.

+WPRSSI to verify that you have acquired a channel and the NAM will register. The reply
to thiscommand isin four lines:

Signal strength in dBm (-0 indicates no signal)

Channel state where 1 indicates scanning and 3 indicates an acquired channel

Registration state where 0 indicates your NAM is not registered, and 1 indicates registration
Channel number (0 indicates scanning).

Use A/ to repeat the RSSI query until your modem can find a channel and register the NAM.
If the modem fails to register the NAM on a channel after one minute then your NAM does
not likely have service in the coverage area.

When the RSS! reports the modem has registered the NAM:

5. ATDnum where num is atelephone number that you can call to detect aring. Thiscan bea
voice line at or near your workstation. The modem will dial the number and you should hear
the ring and see aring indication reply on the host terminal application.

If you dia adestination modem set to auto-answer, the handshake should complete and the
connection result will be reported. Y ou can terminate the connection normally.

6. If you call aline which does not answer, press any key to have the modem cancel the call and
return to command state or allow the dial command to timeout.
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6.3. Originate a CSC Connection

CSC operates just like regular landline modems except the call is placed over a cellular network.

Watcher (Section Q) can be used to setup the modem for CSC operation. When set, acall can be
placed using any modem application which can issue adial command to the port.

Alternatively, Windows Dial-up Networking can be configured to establish a connection. If Dial-
up Networking (or any other communication application) is used to setup the modem, the setup
string should be:

AT &F5

This command will configure the modem to use ETC settings that improve performance for
cellular connections. See Section 6.5 below for afull discussion of optimized cellular settings.

Y ou may freely add necessary settings to control the local DTE/DCE interface (echo, verbose,
quiet, etc.) without altering the remote connection settings.

6.4. Auto-answer a Cellular Call

Y our application can use the modem just like any landline modem. The modem setup string
should be:

AT &F5
AT S0=n where n is the ring count on which the modem will answer the line.

This setup will configure the modem to use ETC settings that improve performance for cellular
connections. See Section 6.5 below for afull discussion of optimized cellular settings.

Y ou may freely add necessary settings to control the local DTE/DCE interface (echo, verbose,
quiet, etc.) without altering the remote connection settings.

6.5. Optimizing Data Performance

The SB320 modem can be configured for excellent cellular performance. The AT&T Paradyne
Comsphere product line is recommended as the landline side. Alternatively cellular modem pools,
sometimes supplied by the cellular service provider are normally good for performance, although
they too need to be properly configured by the cellular carrier to optimize the performance.

The SB320 modem supports V.34 protocol allowing it to achieve higher connection speeds, and to
optimize its filter characteristics dynamically to get the best Signal-to-Noise Ratio (SNR) on a
given link. This makes for amuch more robust and faster connection and speeds of 19200 bps are
not uncommon with this modem if the host supports V.34 as well.

To help determine the nature of the connections being established in trials it may be useful to have
the modem report a more extensive reply. Setting S95=127 will enable the modem to report the
DCE connection speed, protocol, and compression negotiated.

A number of connection scenarios between a SB320 and a variety of host modems are considered
in the following sections in an attempt to present a guideline to improve connectivity. The host
modems are divided in two categories: those that support ETC and those that don’t. Of those
modems that don’'t support ETC, afurther differentiation is made with regard to those that support
LAPM/V .42bis and those that don’t. Finally, modem pools with *DATA service are considered
as a separate category, even though these modems do implement ETC.

But first the factory settings are described as a reference point.

Page 60

Proprietary and Confidential 2110059 Rev 1.1



User’'s Guide

CSC Operation

6.5.1.

6.5.1.1.

Factory Default for ETC

The &F5 command will configure the SB320 for optimal performance on most cellular systems.
This AT command is designed to make it easy for the user or application to set up the modem in
ETC mode. Sending just this one command will cause the modem to reconfigure all its registers,
including those that are not associated with ETC, to factory default and optimized for ETC
operation.

It isequivalent to sending AT&FO followed by a series of additional AT commands and S
Register settings which pertain to ETC mode. Thisiswhy it can be thought of asa‘super’ AT
command. A brief description and commentary of each of these additional settingsis given
below.

\N5 Enables V.42 LAPM error control only. Thisisarequirement of ETC. The
modem will disconnect if the remote end does not support LAPM.

-KO Thisis a companion to the above command indicating a preference for LAPM
when using V.42.
*H2 This sets the Link Negotiation Speed for the initial connection to 4800 bps. The

policy of “start dow and train up” guarantees that the initial negotiation phase
has more chance of success. Start-up speeds of 4800 bps and 9600 bps (*H3)
may be used. In addition if a connection has not been established after 60
seconds, the modems will fall back to 1200 bps.

S7=120 The Wait for Carrier is set to 120 seconds. The handshaking process with ETC
enabled and cellular generally can take longer than the default 50 seconds. This
is especially true of modem pools are being used.

S10=100 Lost Carrier Hang-up Delay is set to 10 seconds. The default is 0.6 seconds but
cellular links can be interrupted during cell changes and due to other “noise” so
the modem will wait longer to determine if the connection istruly lost.

S51=15 This sets the V.34 symbol rate to 2800 symbols per second and the carrier
frequency control to automatic for transmissions. The default would allow 3429
symbols per second, which is likely to lead to more failures and retransmissions.

S52=15 This does the same as S51 but for the V.34 receive side.

S55=37 V.34 options are set to enable asymmetric bit rates, and non-linear encoding. It
disables asymmetric rates, constellation expansion and receiver pre-encoding.

S70=20 This extends the maximum number of retransmissions from the default 12 up to
20.

S96=31 ETC Options are set to enable all features for ETC handshaking. Thisincludes

enabling afallback to 1200 bps if higher rates cannot be supported. It also
enables /ETC to be appended to the CONNECT message.

S106=32 The frame size for LAPM is set to the minimum 32. The default is the maximum
of 128. Use of asmall frame size does reduce direct throughput, but gives a
more robust connection. This leads to fewer retransmissions and can improve
overall throughput in noisy connections that require frequent retransmissions.

S108=3 Signal Quality is selected to high, meaning that automatic re-training is activated
at the most sensitive setting. This means that the modem will re-train on dlight
changesin line quality. Thisisintended to keep the rate as high as practical.

Data Rate

Even with optimal configuration, modems will have a tendency to attempt to communicate at a
datarate that is faster than optimal for overall throughput. For this reason it is recommended that
register S37 (Desired DCE Speed) be used to limit the maximum data communications rate. This
register can be set as part of the initialization string eg. ATS37=7.
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6.5.2.

6.5.3.

Remember that the factory setting above sets the speed for the initial negotiation at 4800 bps but
the modem can train up to amaximum set in S37. The default value for S37 isto connect no
faster than the DTE connection speed (currently fixed at 19200 bps). Thiswill happen only if the
line conditions allow it. Otherwise, the modem will connect at alower speed.

If the modem is found to be training up and down too often due to a constantly changing line
quality, it may be better to reduce the upper limit to 7200 bps (s37=8) or 4800 bps (s37=7). This
will result in a more stable connection and eliminate excessive speed negotiation. Thisisfeasible
if speed isnot critical to the application or if small amounts of data are transferred at any one time.

Alternatively, if retraining istoo frequent, the line quality threshold for retraining can be shifted
down using S108. This should only be tried under controlled trial conditions to determine the best
balance between signal threshold and maximum line speed. Transmitting a 100k test file gives a
reasonable measure of throughput efficiency.

Based on field experience using the &F5 settings, the following limits are recommended:
V.32bistaking to cellularly aware landline modem — 9600 bps (S37=9)
V.32bistaking to standard wireline modem — 4800 bps (S37=7)

V.34 talking to cellularly aware modem — 12000 bps (S37=10)
V.34 talking to standard wireline modem — 9600 bps. (S37=9)

If only asmall amount of datais being transferred, it is recommended that a data rate of 4800 bps
(S37=7) isused. Thiswill give optimal performance and coverage area. Error Correction should
always be enabled. Flow control should be used (hardware recommended).

For situations where even 4800 bps does not hold a connection, the last suggestion isto try a data
link at 1200 bps (s37=5).

Connections to ETC Enabled Modems

Enhanced Throughput Cellular (ETC) is a protocol enhancement designed to optimize cellular
data communications. It isdescribed in Section 4.5.2.1.

Thisisthe best case scenario and it should be possible to achieve speeds of 9600 — 19200 bps if
the host supports V.34 and ETC. The table below lists some of the steps for troubleshooting bad
connections at both the SB320 end and the Host modem end. Asarule, when starting the
troubleshooting procedure, both modems should be reset to their respective factory defaults
settings. If problems still persist, then a more thorough analysis of each modem'’ s settings needs
to be done as outlined below.

Connections to Non-ETC Compatible Modems

If the remote modem does not support LAPM and V.22bis then you will have to alow the SB320
to use aternative protocols. The &F0 command isused. This AT command configures the
modem in CSC data mode but without ETC enabled.

An additional series of AT commands and S-Register settings should also be set to optimize the
modem to operate in a cellular environment without the benefits of the ETC protocol. This non-
ETC configuration will then allow the modems to negotiate other protocols such as MNP, etc.

The following additional commands should be sent to configure the modem for CSC mode use
with non-ETC compatible modems:

\N3 Enables V.42 LAPM error control but also allows MNP and will even tolerate a
non-error controlled link. A setting of 2 is aso possibleif you want to
disconnect if neither LAPM nor MNP error control can be negotiated.

-KO Thisis acompanion to the above command indicating a preference for LAPM
when using V.42.
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*H2 This sets the Link Negotiation Speed for the initial connection to 4800 bps. The
policy of “start ow and train up” guarantees that the initial negotiation phase
has more chance of success. Start-up speeds of 4800 bps and 9600 bps (*H3)
may be used. In addition if a connection has not been established after 60
seconds, the modems will fall back to 1200 bps.

S7=120 The Wait for Carrier should be set higher than the default 50 seconds to allow for
the added time of cellular (and possibly modem pool) connections. This sets the
wait to 120 seconds.

S10=100 Lost Carrier Hang-up Delay is set to 10 seconds. The default is 0.6 seconds but
cellular links can be interrupted during cell changes and due to other “noise” so
the modem will wait longer to determine if the connection istruly lost.

S51=15 This sets the V.34 symbol rate to 2800 symbols per second and the carrier
frequency control to automatic for transmissions. The default would allow 3429
symbols per second, which is likely to lead to more failures and retransmissions.

S52=15 This does the same as S51 but for the V.34 receive side.

S55=37 V.34 options are set to enable asymmetric bit rates, and non-linear encoding. It
disables asymmetric rates, constellation expansion and receiver pre-encoding.

S70=20 This extends the maximum number of retransmissions from the default 12 up to
20. Higher values are possible if needed.

S106=32 The frame size for error correction protocolsis set to the minimum 32. The
default is the maximum of 128. Use of asmall frame size does reduce direct
throughput, but gives amore robust connection. This leads to fewer
retransmissions and can improve overall throughput in noisy connections that
require frequent retransmissions.

S108=3 Signal Quality is selected to high, meaning that automatic re-training is activated
at the most sensitive setting. This means that the modem will re-train on dlight
changesin line quality. Thisisintended to keep the rate as high as practical.

The data rate discussion in Section 6.5.1.1 also applies to this type of connection.

Connections to Modem Pools

This scenario is aso abest case scenario and it should again be possible to achieve speeds of
19200 — 9600 bps in most circumstances. Modem pools are discussed in Section 6.1.3 above.

The SB320 connection is a cellular one and therefore its pool counterpart will be an ETC-capable
modem. This means that the SB320 should be configured in its factory default ETC mode using
ATE&F5 as described earlier.

The destination modem’ s connection to the pool is a standard landline connection and the remote
modem must be configured as such. In this case the destination modem should be configured to
support the full array of protocols to give it the best possible options for connecting to the cellular
carrier’s modem pool on the landline side.

If any configuration adjustments are to be made, understand that you are either optimizing the
connection from the SB320 to the pool modem or from the destination modem to the pool and not
directly between the SB320 and the destination.
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7. Wireline Operation

7.1. Introduction

Wireline data mode is that most commonly associated with computer communications: the modem
is connected via atelephone line. Only the SB320 supports this mode.

This section provides information on configuring and using the SB320 modem in Wireline data
mode if you are not using Watcher and Windows Dial-up Networking for your connections. If
you are using a standard Windows-based application then consult Section 3.3 Configuration using
WirelessExpert.

For details on Wireline Voice operation see Section 8 Voice Operation in CSC and Wireline.
7.1.1. Hardware

To connect the SB320 to a telephone line the 13-pin /O connector isused. Pins 12 and 13 arethe
wireline RING and TIP respectively.

For testing purposes, the MIB supports connection of the SB320 to a telephone line with a RJ-11
connector (PSTN). The SB320 I/0O connector must also be in place.

CAUTION

The telephone connection must be to a standard analogue telephone line. Locations
which have an internal PBX telephone system may use digital telephone lines
internally. Digital lineswill NOT work with the modem.

P
£ @
|

The modem’ s load number (5B) is noted on the modem'’ s back label.

7.2. Configuring the Modem for Wireline

The modem does not require any special configuration for Wireline mode. The modem is placed
in Wireline mode by setting +WS46=1.

7.2.1. Connecting to another Wireline Modem or Modem Pool

The factory settings (&FO0) are fine for wireline operation. The modem will enable all protocols
up to V.34. ETC for cellular connections is disabled by default.

7.2.2. Connecting to a Cellular Modem

If the destination modem is on a cellular network, you should familiarize yourself with the
considerations discussed in Sections 4.4 and 4.5 on protocols and handshaking. The discussion on
CSC in the section above is a so worth reading to understand the kinds of issues that can arise.

For these types of connections you should issue the “super” AT command &F6 which
automatically includes additional setup commands as follows:

\N3 Enables V.42 LAPM error control but also allows MNP and will even tolerate a
non-error controlled link. This allows for both adirect ETC connection to the
destination and a non-ETC connection to a modem pool. A setting of 2 isalso
possible if you want to disconnect if neither LAPM nor MNP error control can be
negotiated.
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-KO Thisis acompanion to the above command indicating a preference for LAPM
when using V.42.

*HO This sets the Link Negotiation Speed for the initial connection to a maximum
equivalent to the DTE speed. It will adapt to the speed of the other modem.

S7=120 The Wait for Carrier is set higher than the default 50 seconds to allow for the

added time of cellular (and possibly modem pool) connections. This sets the
wait to 120 seconds.

S10=100 Lost Carrier Hang-up Delay is set to 10 seconds. The default is 0.6 seconds but
cellular links can be interrupted during cell changes and due to other “noise” so
the modem will wait longer to determine if the connection istruly lost.

S51=15 This sets the V.34 symbol rate to 2800 symbols per second and the carrier
frequency control to automatic for transmissions. The default would allow 3429
symbols per second, which is likely to lead to more failures and retransmissions.

S52=15 This does the same as S51 but for the V.34 receive side.

S55=37 V.34 options are set to enable asymmetric bit rates, and non-linear encoding. It
disables asymmetric rates, constellation expansion and receiver pre-encoding.

S70=20 This extends the maximum number of retransmissions from the default 12 up to
20. Higher values are possible if needed.

S96=29 ETC Options are set to enable al features for ETC handshaking except cellular

network compensations are not enabled since your end is non-cellular. This
includes enabling a fallback to 1200 bps if higher rates cannot be supported. It
also enables /ETC to be appended to the CONNECT message.

S106=32 The frame size for error correction protocolsis set to the minimum 32. The
default is the maximum of 128. Use of asmall frame size does reduce direct
throughput, but gives amore robust connection. Thisleads to fewer
retransmissions and can improve overall throughput in noisy connections that
require frequent retransmissions.

The data rate discussion in Section 6.5.1.1 also applies to this type of connection.

7.3. Originate a Wireline Connection

Watcher (Section Q) can be used to set the modem to Wireline operation. When set, a call can be
placed using any modem application which can issue adial command to the COM port.

Alternatively, Windows Dial-up Networking can be configured to establish a connection. If Dial-
up Networking (or any other communication application) is used to setup the modem, the setup
string should be:

AT &FO for callsto awireline modem destination
—0OR -
AT &F6 for callsto acellular modem destination

Y ou may freely add necessary settings to control the local DTE/DCE interface (echo, verbose,
quiet, etc.) without altering the remote connection settings.
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7.4. Auto-answer a Wireline Call

Y our application can use the SB320 modem just like any other landline modem. The modem
setup string should be the appropriate factory setting as indicated in Section 7.3 above. To enable

auto-answer add:
AT S0=n where n is the ring count on which the modem will answer the line.

Y ou may freely add necessary settings to control the local DTE/DCE interface (echo, verbose,
quiet, etc.) without altering the remote connection settings.
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8. Voice Operation in CSC and Wireline

8.1. Introduction

This section provides preliminary information for using the voice features added to firmware
revision 1.1.2 of the SB320 multi-mode modem. V oice features are implemented for beta testing
only at thistime. Full FCC and Cellular compliance has been verified but FCC approvals have not
yet been received.

The implementation of voice capability in wireline and CSC modes allows the user to place and
receive voice calls over the telephone network (PSTN or AMPS). The call usesthe airlink or line
connected to the modem and the MIC and SPKR signals to carry analogue traffic. Thisisnot a
form of digitized voice traffic like some Internet voice applications.

Voice calls can be treated like any landline or cellular call with the SB320 replacing the telephone
or cellular handset. The MIC and SPKR signals are used for the local “handset” end. The TIP and
RING signals are used for the wireline connection to the PSTN. CSC AMPS calls are connected
through the modem / radio components of the SB320.

8.2. Setting Voice Mode

8.2.1.

Both wireline and CSC connections can support voice calls. CDPD is specifically a packet data
protocol so voice is hot supported in that mode.

Register +WS46 (Modem Operating Mode) controls the modem’s mode. Two new values have
been added to set voice modes depending on the type of connection to use.

+WS46=17 sets CSC AMPS Voice mode.
+WS46=18 sets Wireline Voice mode.

Changes into these modes can made from any other mode.

Command and Register Profiles

The settings of commands and registers are called a profile. The modem can store three profiles.
Two profiles are shared by Wireline and CSC modes; athird profile is unique to CDPD mode.
Profiles are saved using the &W (Write Active Profile) command.

Upon reset or modem initialization, a profileis restored to the modem based on the mode and a
selection made with the &Y (Profile on Reset) command. Changes to the profile which are not
saved are lost on the next initialization. Note that the modem performs an initialization, resetting
the profile, whenever the mode is changed to Wireline (1) or Wireline Voice (18).

The parameters that control the MIC and SKPR settings (described in Section 8.5 below) are not
part of asaved profile. Future implementations will allow saving the voice control parameters.
See Section 8.5 below for details on adjusting these controls.
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8.3. Placing a Voice Call

The follow procedure applies to placing voice callsin both Wireline and CSC modes. Where CSC
mode is used, the modem must have been configured with aNAM and be registered with the
cellular service provider.

To place a call enter the following commands (the AT is omitted for brevity):

1. +WS46=n where n isthe mode choice of either 17 for CSC Voice or 18 for Wireline Voice.
2. Dn where n isthe telephone number to dial.

The modem will enable the microphone and speaker, and dial the number. Y ou are considered
off-hook (online condition) until you explicitly hang up the call. The modem remainsin

command state allowing you to enter AT commands to: monitor the RSS!, adjust the microphone
sensitivity and speaker volume, and terminate the call.

During the call you can adjust the microphone and speaker levels as described in Section 8.5
below.

See Section 8.6 below for instructions on terminating a call.

8.4. Receiving a Voice Call

Although the modem is capable of receiving and answering voice calls, thisis not considered a
common procedure.

The follow procedure applies to answering voice cals in both Wireline and CSC modes.

To receive acall enter the following commands (the AT is omitted for brevity):

1. +WS46=n where n isthe mode choice of either 17 for CSC Voice or 18 for Wireline VVoice.

2. S0=1 to enable auto-answer. You may set to avalue higher than 1 if you would like the
modem to go off-hook on a later ring.

The modem is now enabled to answer callsin voice mode. When a call arrives, the modem will
display aRING message. The RI signal will behave normally: active while receiving aring and
inactive between rings.

NOTE

If S0=0, the modem will still display the RING message when a call arrives, but this
revision of firmware does not support manual answer. Future implementations will
allow manual answer using the A (Answer — Manual) command.

Upon reception of the number of rings specified in register SO the modem will go off-hook and
enable the microphone and speaker. The modem will remain off-hook (online condition) until you
explicitly hang up the call. The modem remains in command state allowing you to enter AT
commands to: monitor the RSSI, adjust the microphone sensitivity and speaker volume, and
terminate the call.

During the call you can adjust the microphone and speaker levels as described in Section 8.5
below.

See Section 8.6 below for instructions on terminating a call.
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8.5. Adjusting MIC and SPKR Levels

The modem has two gain controls for each of the MIC and SPKR signals. A coarse control sets
the level of the automatic gain control (AGC). A fine control adds additional resolution.

Setting these levelsis achieved with the +WV commands noted in the command reference in the
next section. Currently there is no way to query these settings but that capability will be added in
future revisions of the firmware.

Asdiscussed in Section 8.2.1 above, these settings are not saved with the profile when & W is
used. The coarse gain settings are retained until the modem is re-initialized, but the fine gain
controls are reset to default with each call. A future revision of firmware will preserve all settings
between calls and permit storing the setting profile for recall during modem initialization.

At thetime acall is connected, the coarse gain settings are the same as the previous call, and the
fine gain settings revert to default. The modem remains in command state during the call allowing
changes to the settings as needed.

8.6. Terminating a Voice Call

When acall is connected the modem will remain in the on-line condition (off-hook) until
commanded to hang-up with the HO (Hook Control) command. If the other end hangs-up (goes
on-hook), the modem will remain off-hook and noise will be heard on the SPKR line.

The modem cannot detect alost voice connection. Only manual disconnection of the call is
possible.
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9. Troubleshooting

9.1. Introduction

Some solutions to common problems are described here. They are grouped along the lines of the
four operations chapters. General problems communicating with the modem in the first section
and issues which are specific to particular modes in subsequent sections.

An up to date troubleshooting guide will be available on the Sierra Wireless Internet site at
Www.sierrawireless.com.

If you cannot resolve a problem after reading this chapter and consulting our web site, please
contact the Sierra Wireless help desk at (604) 231-1128 (between 06:00 and 17:00 Pacific Time)
or e-mail us at support@sierrawireless.com.

9.2. General Modem Problems

The SB300 Series modems are thoroughly inspected during manufacture. There are no end-user
access items within the case or on the circuit boards of the modem. If problems occur, check the

following:

Problem Description

Suggestions

WirelessExpert failsto setup
Windows Dia-up
Networking Connection

Watcher fails to locate the
modem.

Use the Windows Start > Settings > Control Panel > Modems to
install the Sierra Wireless modem.

Modem fails when
transmitting.

The LED indicator
(SB300/320) does not light.

Check that the power source has adequate voltage and current. The
modem requires regulated 5 Vdc at 850 mA. If the power is marginal it
can be the problem. The SB300 Series modems draw up to 850 mA
under maximum power output. The power output is a function of the
modem’ s distance from the Mobile Data Base Station. It is possible for
the modem to work well with a particular power supply in alocation
requiring low power output (low current draw), and yet to fail using the
same power supply in alocation requiring a high power output.

Check the amperage rating of the power supply to verify that it is
adequate for all situations.

Check the fuse (if any) in the power source and as afinal test use a
voltmeter to check for an open cable.

Modem disconnects or resets
intermittently.

Ensure the DTR signal is not floating or being changed by the host.
Set AT&DO to have the modem ignore DTR.

Verify that CSC radio signal strength is sufficient. Weak signals may
cause loss of carrier and subsequent disconnection. Use higher values
inregister S10 (Lost Carrier Hang-up Delay).

AT commands are sent to
configure the modem but the
modem does not use the
settings when running an
application.

Verify that the application does not send its own modem setup
commands after you have configured the modem. If it does, then either
disable the feature or set your configuration in the application’s setup
string.
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9.3. General Communication Problems

Problem Description

Suggestions

Failsto respond to AT
command.

Verify that you are using the correct COM port and communication
parameters (speed, data bits, parity, etc.)

Verify the serial cable connections.

Verify the modem is powered on and allow for 10 seconds initialization
time.

Try typing the command ATE1QO. Thiswill enable the modem echo
of your keystrokes (in following commands) and disable the quiet mode
(suppression of return codes).

Try typing AT&F. Thisrestores factory defaults.
Try resetting the modem.

Dataisintermittently lost
during the connection.

Ensure that proper flow control isbeing used at al connections.

If UDP is used, remember that datalossisinherent in the design.
Implement a positive acknowledge and timeout scheme at the
application level with re-transmissions as needed.

If the connection is CSC mode, try setting a slower data rate (register
S37).

9.4. CDPD Problems

Thistable lists problems specifically related to CDPD use.

Problem Description

Suggestions

Failsto lock onto a CDPD
channel.

Make sure that the antenna is connected correctly.

Check that you are in the CDPD coverage area, or that your immediate
location is not preventing the radio/modem from receiving asignal, e.g.,
you are in an area of weak signal strength.

Failsto register on aCDPD
channel.

Make sure the NEI and side designator are configured correctly.

Make sure you are using the correct registration mode (auto or manual)
and are issuing the registration command if using manual registration.
If ATH1 was issued, the modem will not resume auto-registration until
the modem is reset or the command AT+WS173=1 isissued to re-
enable auto-registration.

Check that the correct NEI is being used (Active or Auto-register NEI
Indices) and the SPNI table. Anincorrect value will prevent registration
even in areas with strong signals. Erase the SPNI table if necessary.

Check with your CDPD service provider to confirm that your account is
activated. Y ou may need to reset your credentials.

Registers but data transfer
falls.

Check that the host serial cableis properly attached.
There may be aflow control problem.

Slow response from the
CDPD network.

The CDPD network may be congested with heavy use. No user action
can dleviate this problem. Retry your connection later.
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CDPD Problems (Continued)

Problem Description

Suggestions

Watcher reports: CDPD ras
connection is not running.

Close all communication applications, then close and restart Watcher.

Watcher reports agood
connection and you are
registered to a CDPD
network however your
Internet Web Browser can
never find sites.

Make sure the DNS entry in Dial-up Networking is correct. Thisisthe

I P address of the Internet Domain Name Server responsible for
converting site names into Internet Protocol (1P) addresses. Without the
correct |P of aname server your browser cannot locate web sites.

9.5. CSC Probhlems

This table lists problems specifically related to CSC use.

Problem Description

Suggestions

Failsto acquire a Cellular
channel.

Make sure that the antenna is connected correctly.

Check that you are in the cellular coverage area, or that your immediate
location is not preventing the radio/modem from receiving asignal, e.g.,
you arein an area of weak signal strength.

Acquires a channel but
cannot place acall.

Make sure the NAM and side designator are configured correctly.
Check that the correct NAM is being used (Active NAM Index).

Check with your Cellular service provider to confirm that your account
is activated.

If the cellular network becomes congested due to heavy cellular user
traffic, you may not be able to establish a connection. No user action
can aleviate this problem. You will haveto retry your connection later.

9.6. Wireline Problems

This table lists problems specifically related to wireline use.

Problem Description

Suggestions

The Speaker onthe MIB is
excessively noisy.

The modem was in CDPD mode and changed to Wireline. When this
mode change was done, the cellular radio was not powered off. Power
cycle the modem to ensure the radio is off.

The modem does not go off-
hook to place or answer calls
or intermittently disconnects.

Verify the telephone cable connections at both ends. Y ou may need to
attach a handset to the line to verify that the PSTN serviceis active and
connections are clear (free of noise, interference, tones, etc.).

Additionally see the following symptoms and suggestions.

The modem does not go off-
hook to answer incoming
cals.

Verify the auto-answer is enabled (register S0).
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Wireline Problems (continued)

Problem Description

Suggestions

The modem does not go off-
hook and begin dialing.

Verify the duration of DTMF tones (register S11) is sufficient to break
dial tone.

Verify the telephone line is analogue and not digital.

The modem won’t recognize
thelocal dial tone.

Disable the dial tone detection using ATX0 or ATX1. Ensurethe
setting of Wait For Blind Dia (S6) is sufficiently long.

Modem intermittently
disconnects.

Ensure the telephone line does not support call waiting. If it does then
disable the feature. Consult your local telephone company to determine
how thisis done.
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The Hardware View

10. Product Descriptions

The SB300 Series modems are designed for integration into devices that require wireless
communications such as PC’s, portable and handheld devices, metering and monitoring
equipment, and point of sale terminals.

All models provide CDPD V1.1 19.2 kbps communication. The SB320 also supports Circuit
Switched Cellular (CSC-AMPS) V.34 datarates to 16.8 kbps, and wireline (PSTN) V.34 data
rates to 33.6 kbps.

Packet Assembly / Disassembly (PAD) services are available in the modem for TCP and UDP
communications. SLIP and PPP are also supported for host based protocol stacks.

This chapter provides descriptions and specifications for the family. Individual modems are
described in separate sections below. All connector parts described are tabulated with mating part
numbers and supplier contact information in Section 10.2.4 below.

The SB300 and SB320 share common physical and interface characteristics.

10.1. Hardware Integration Considerations

When integrating one of the SB300 Series modems, read Sections 10.2 Specifications Common to
All Modems, and then the specific section for the model being integrated.

In addition, the following items need to be addressed by the integrator:

Mounting
Effects of shock and vibration.
Protection from dust and dirt in connections.
Heat dissipation.

RF
Shielding and filtering, and impacts on interference and sensitivity.
Antenna location and type, and impacts on RF performance.

Regulatory Approvals

Although the modems were tested on their own to be compliant with FCC Parts 15 and 22, your
completed installation must be certified to meet regulatory requirements in your area.

In the USA

To use the modems in the United States of America without additional FCC certifications you
must:

1. Usean antenna providing atotal system ERP (effective radiated power) not exceeding
1.5 watts for operations with the antenna located at more than 20 cm from all persons. If the
system exceeds 1.5 watts ERP then separate submissions to the FCC are required.

2. Place awarning label on the antenna (if stand-alone) or attached to the final product visible to

all persons exposed to the transmitter (if the antennais integral with the final product). This
label must state:
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“WARNING:
Whilethisdeviceisin operation, a separation distance of at least 20cm must be
maintained between the radiating antenna and the body of all persons exposed to the
transmitter to meet FCC exposur e guidelines.”
3. Theword “WARNING” should be placed in front of or above the warning statement included
in documentation and aso in the actual warning label on the antenna or final product.

Thiswarning label is not required when Specific Absorption Rate (SAR) compliance of afinal
product configuration is approved through a separate FCC equipment authorization approval.
Otherwise, the warning label is required on the antenna or final product in order to meet separating
distance requirements to satisfy the FCC RF exposure requirements.

Product documentation should include warnings and disclaimers. Sierra Wireless strongly
recommends including warnings similar to those found on pagesi and ii of this Guide. The
following warnings must appear in a prominent location:

The equipment certifications appropriate to your device are marked on the device and the accompanying product
specific information. Where appropriate, the use of the equipment is subject to the following conditions:

A

CAUTION

Unauthorized modifications or changes not expressly approved by Serra Wireless, Inc.
could void compliance with regulatory rules, and thereby your authority to use this
equipment.

A

WARNING (EMI) - United States FCC Information

This equipment has been tested and found to comply with the Class B limits pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in an appropriate installation. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio
communication. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interferenceto radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measur es:

Reorient or relocate the receiving antenna

Increase the separation between the equipment and receiver

Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected

Consult the dealer or an experienced radio/TV technician for help

WARNING - FCC RF Exposure Guidelines

While this device isin operation, a separation distance of at least 20cm must be
maintained between the radiating antenna and the body of all persons exposed by the
transmitter to meet FCC exposure guidelines.

This transmitter is only approved to operate with an antenna not exceeding 1.5 watts
total system ERP (effective radiated power) for operations with the antenna located at
more than 20 cmfrom all persons. The warning label must be displayed at the base of
the antenna (if stand-alone) or attached to the final product (if the antenna is integral
with the product), clearly visible to all persons exposed to the transmitter.
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10.2. Specifications Common to All Modems

The following specifications provide information on all SB300 Series modems.

10.2.1. Application Interface Specifications
19200 bps (current firmware R1.1.x)
Serid Interface (DTE) 300 — 57,600 bpsin CDPD via +IPR command
(auto-baud support in future firmware)
SLIP Interface RFC1055
PPP Interface (future firmware) RFC1661, RFC1662, RFC1332 (not yet implemented)
AT-Command Interface Hayes Compatible with PCCA Wireless Extensions
UDP PAD Interface PCCA STD-101 Compliant
TCP PAD Interface PCCA STD-101 Compliant
Object Management Interface SierraWireless Inc. Proprietary
10.2.2. Special Features
Feature Benefit
Sleep Mode Reduces current drain for improved battery life.
TCP and UPD PAD Ping Reply Confirm network connectivity to the modem.
Broadcast Message Support Broadcast to all modems in geographic area.
TCP Session Time-out Permits reconnection of failed TCP session.
“Friends-only” modem access Provides device security.
AutoDial at Startup Modem automatically establishes communications.
Software-controlled Reboot Quick problem recovery.
Autobaud Flexible interface
MultiCast Broadcast to defined subset of al modems.
Configurable Listening Port Modem can listen on any port the host prefers.
Escape from PAD modes Non-DTR controlled Escape.
10.2.3. Environmental Specifications
SB300 SB320
Operating Temp. | -30 to +60°C -30to +60°C
Storage Temp. -40t0 +85°C -40t0 +85°C
Humidity 5% to 95% 5% to 95%
non-condensing non-condensing
Vibration Operational: 1S-19C Operational: 1S-19C
Survivability: Mil-STD202 Survivability: Mil-STD202
Shock 1 metre drop to a hard surface 1 metre drop to a hard surface
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10.2.4.

10.2.4.1.

10.2.4.2.

Connector Part Numbers

This section summarizes the parts used, their mating parts, and identifies the suppliers so that you
can acquire the needed connectors for the host equipment / accessories.

Antenna Connector

All models of the SB300 Series use the same MMCX type antenna connector.

Modem: Huber & Suhner 85 MMCX-50-0-1 | Female
Suggested Antenna Cable Huber & Suhner 11 MMCX-50-1-1 | Male
Connectors: Straight plug for RG 178 B/U

Huber & Suhner 16 MMCX-50-1-1 | Mae
Right angle plug for RG 178 B/U

Huber & Suhner can be contacted via www.hubersuhner.com.

SB300 and SB320 Host (DTE) Connectors

The SB300 and SB320 both use a 30-pin ZIF connector with 0.5mm pin spacing for the host serial
connection. The connection is made using a 30-pin 0.5mm pitch Flat Flex Cable. The host end of
the cable can be connected as suits your needs.

SB300/ 320 Modems: Hirose FH12-30S-0.5SH

Hirose can be contacted via www.hiroseusa.com.

The Cable can be obtained from several suppliersincluding:
Axon Cable (www.axoncable.com) 847-699-8822
Parlex Corp
Fujikura America, Inc. (www.fujikura.com) 619-613-6600

Suggested pdA number FFC0-50A30/043L440B0OBSB
0.5 mm pitch
30 conductor
51 mm LOA

SB320 Wireline Connector

The SB320 has an additional wireline connector for connection to the telephone network viathe
host. Thisisa13-pin /O connector.

SB320 Modem: ITT-Cannon CA112112-1 Male
Host Wireline Connection: Contact ITT-Cannon Female

ITT-Cannon can be contacted via www.ittcannon.com.

Small quantities of these mating components may be obtained from Sierra Wireless, Inc. Contact
Sales at 604-231-2100 or sales@sierrawireless.com.
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10.3. SB300 CDPD Modem

Part number 1100034

10.3.1. Mechanical

10.3.1.1. Physical Description

The SB300 comesin aType Il package, and
includes a 30-pin, 0.5mm pitch ZIF connector for
the host interface, aMMCX connector for the
antenna, and a status LED. Dimensions (in mm) are as follows:
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540 486 2 380 T K i
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SECTION B - B

Figure 10-1: SB300 Physical Dimensions [mm].

10.3.1.2. Mounting

The SB300 uses an industry standard Type |11 frame-kit, and as such will fit into PC Card rails.
Alternatively, two clips or a bracket may be used to secure the module. There are also two
mounting holes provided on either side of the ZIF serial connector.

Figure 10-2: SB300 Package Views.
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10.3.2. Connectors
See Section 10.2.4 for part number and manufacturer contact details on all connections.

10.3.2.1. Antenna Connector

The SB300 provides an MM CX type RF connector for the antenna connection. For proper
matching the antenna should be 50 ohms with a return loss of 10 dB or better between
824 - 894 MHz. System antenna gain should be O dB.

New production units will include support for the future Sierra Wireless booster product. This
support means that extra care is required when connecting the antenna output to test equipment.

CAUTION

In cases where the antenna output is to be connected to test equipment, DC blocks must
be used on the antenna output to protect the test equipment and avoid fal se booster
detection..

-
L
|

10.3.2.2. Host (DTE) Connector

The SB300 provides a single 30-pin ZIF connector with 0.5mm pin spacing. An appropriate Flat
Flex Cable isrequired to make the connection to the host.

10.3.3. Power Specifications
The SB300 requires +5V DC provided on pins 23-24, and ground provided on pins 23-28.
Electrical requirements and current specifications are identified below.

Power-up timing for the modem requires that power ramp up at a minimum rate of 0.05 V/ms
within amaximum of 100ms. The ramp up should be graceful and linear (monotonic).

Table 10-1: Power and Current Specifications

+5V DC 5%

Power Supply Requirements
PRIy el Maximum noise DC to 100 kHz: 10 mV/,

Deep Sleep: 12 mA
. Sleep: 16 mA
Current Drain Receive: 150 mA

Transmit (Full Power): 850 mA

Note: Early production units used different internal components and may require 20 mA more
than noted above while in receive modes. The command ATI6 will report the hardware revision.
Units prior to 0062 use the higher current level.

10.3.4. Heat Dissipation

The figures below indicate excess power dissipation beyond that radiated by the antenna.

Table 10-2: Power Dissipation Specifications

ﬁg;%;;anpm gr' ng a 3.65 Watts
CDPD Sleep 325 mwW
Logic Sleep 110 mwW
Logic Deep Sleep 85 mw
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10.3.5. RF Features
Transmitter Power nomina 600 mw into 50 W
Transmitter Performance Meets or exceeds CDPD V1.1 Section 405
FCC, Industry Canada, IS19B/C
Receiver Sensitivity -108dBm 5% BLER
10.3.6. Electrical
10.3.6.1. Host (DTE) Interface
The SB300 provides a single 30-pin ZIF connector with 0.5mm pin spacing. This connector
provides four interfaces:
4, Seria host interface
5. Modem control interface
6. Power
7. Statuslineinterface
The connector pinouts are specified in Table 10-3, and electrical characteristics are specified in
Table 10-4 Seria Interface Electrical Characteristics. Signal types are with respect to the
modem (DCE).
Table 10-3: Host Interface Connector Pinouts
Pin Number | Pin Label Type Description
1 \DCD Output Data Carrier Detect
2 RxD Output Receive Data
3 TxD Input Transmit Data
4 \DTR Input Data Termina Ready
5 GND Ground Ground
6 \DSR Output Data Set Ready
7 \RTS Input Ready To Send
8 \CTS Output Clear To Send
9 \RI Output Ring Indicator
10 \RESET Input Hardware Reset
11 Reserved L eave unconnected
12 \SHDN Input Graceful modem shutdown.
13 \STATUS OUT1 Output Power + RF Channel Status
14 \STATUS _OUT2 Output Transmitter Key
15 \STATUS OUT3 Output Power Down OK
16 STATUS IN1 Input
17 STATUS IN2 Input
18 STATUS IN3 Input
19 STATUS IN4 Input
20-22 Unused Allowed to float
23-24 VBAT Input +5V
25-28 GND Ground Ground
29 Unused Allowed to float
30 Reserved L eave unconnected
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Table 10-4: Serial Interface Electrical Characteristics

Characteristic Min.(V) Max.(V)
Input Low Voltage -0.3 0.8
Input High Voltage 25 5.0
Output High Voltage (1oh=400 pA) 24 -
Output Low Voltage (101=3.2 mA) - 0.5

Serial Port Interface

The serial port pins comprise a standard set of serial data and handshaking lines. All signals are
negative assertion, HCMOS logic compatible. These signals must be terminated properly if they
are not used. Unused input signals must be pulled to the appropriate in-active state through a
resistor (10k). Unused output signals may be left unterminated. If asignal may have use asan
input or an output (1/0O) then treat it as an input for termination purposes.

Hardware handshaking should be enabled using \CTS and \RTS as the primary flow control
signals. The remaining handshaking lines \DCD, \DTR, \DSR, and \RI) are, strictly speaking, not
needed; however they are desirable for TCP/IP stack usage and are supported for any applications
that may require them.

Operation in each modeis as follows:
- \RTS,\CTS
Used as standard hardware flow control lines.
\DTR
Indicates to the modem that the host device is active. Thisline may also be configured to
switch the modem from data to command state or reset the modem (AT&D), and to enable
host wake-up. See the \RI description below.
\DCD
Is asserted while online with an active session.
\DSR
Always active when the modem ison; it istied to logic GND.
\RI
Using UDP or TCP packet service in CDPD, \RI toggles with a 1son : 4s off duty cycle when
there is data for the host or a TCP connection request. If \DTR isinactive (high), the\RI
signal will go active through three cycles; otherwise it will go active once only. Thisis
repeated for each incoming packet or connection request until a session is opened. This signal
may be used to wake-up the host.

The serial port should be configured for 8-data bits, no parity bits, and 1-stop bit. Although the
current firmware release (R1.0.1) isfixed at 19200 bps, the eventual default DTE configuration
will auto-baud to the host serial baud rate (based on speed of the ‘A’ in an AT command). Host
datarates of up to 115,200 bps will be supported. AT commands may be used to fix the baud rate
from 110 bps to 115,200 bps.

In command state, aterminal emulation program may be used to communicate with the modem
and change the configuration.

Modem Control Interface

Modem control is comprised of two inputs:

1 \SHDN: Graceful Shutdown
Thisisan active low input.

When activated this signal instructs the modem to de-register from the network, and
power down. When this activity is completed the \STATUS_OUT3 lineis driven low
(on) indicating to the host that power may be safely removed from the device.
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The purpose of this processisto prevent corruption of the data in non-volatile memory.
There is CDPD network housekeeping which goes on transparent to the user. Removing
power or resetting arbitrarily can corrupt thisdata. When the \SHDN signal is detected,
the modem will complete all housekeeping and send the de-register message to the
network before asserting \STATUS _OUTS3.

Timing between the assertion of \SHDN and the reply on \STATUS _OUT3 can range
from a minimum of 20ms and a maximum of 2 seconds. The signal is polled at intervals
of 1 second. Aspects of network traffic at the time the signal is detected also determine
the timing for a giving situation.

The modem must be powered down or reset before it is again ready for use.

2. \RESET: Hardware Reset
Thisis ahardware reset of the modem. Thisinput should be externally pulled high and
driven low for at least 100msto reset.

Status Signal Interface

Status Outputs
There are three status outputs provided. These are active low and defined as follows:

1 \STATUS OUT1: Power, RF Channel Status
Permanently low (on) when power is on but no CDPD channel isvisible. This
output is high (off) when the modem goesinto CDPD sleep.
Pulses low (on) once per second with 10% duty cycle (100ms on : 900ms off) if the
modem is locked onto a CDPD channel.
Pulses low (on) twice per second with 10% duty cycle (100ms on : 100ms off :
100ms on : 700ms off) if modem is registered on a CDPD channel.

2. \STATUS _OUT2: Transmitter Key
Low (on) when the transmitter is keyed.
3. \STATUS OUT 3: Power Down OK

When low (on), thisindicatesit is safe to remove power to the modem or issue a
reset. Thisworksin concert with the\SHDN signal noted above.

Status Inputs

Therearefour TTL-level statusinput lines provided. There are currently no features that use these
inputs. They are managed within the modem and may be left floating.
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10.4. SB320 Specifications
Part number 1100033

10.4.1. Mechanical

10.4.1.1. Physical Description
The SB320 comesin a Type 1l package, and

ncludes a 30-pin, 0.5mm pitch ZIF connector for

the host interface, a 13-pin 1/O connector for the wireline interface, aMMCX connector for the
antenna, and a status LED. Dimensionsin millimetres are as follows:

54.0 486

10.4.1.2.
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SECTION B - B
Figure 10-3: SB320 Physical Dimensions [mm].

Mounting

The SB320 uses an industry standard Type |11 frame-kit, and as such will fit into PC Card rails.
Alternatively, two clips or a bracket may be used to secure the module. There are also two
mounting holes provided on either side of the ZIF serial connector.

Figure 10-4: SB320 Package Views.
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10.4.2. Connectors
See Section 10.2.4 for part number and manufacturer contact details on all connections.
10.4.2.1. Antenna Connector
The SB320 provides an MM CX type RF connector for the antenna connection. For proper
matching the antenna should be 50 ohms with areturn loss of 10 dB or better between
824 - 894 MHz. System antenna gain should be O dB.
10.4.2.2. Host (DTE) Connector
The SB320 provides a single 30-pin ZIF connector with 0.5mm pin spacing. An appropriate Flat
Flex Cable isrequired to make the connection to the host.
10.4.2.3. Wireline Connector
The SB320 provides a single 13-pin I/O connector next to the antenna connector on the side
opposite the host (DTE) connector. This connector may require custom cabling.
The SB320 PSTN Load Number (5B) is shown on the back label.
10.4.3. Power Specifications
The SB320 requires +5V DC provided on pins 23-24, and ground provided on pins 23-28.
Electrical requirements and current specifications are identified below.
Power-up timing for the modem requires that power ramp up at a minimum rate of 0.05 V/ms
within amaximum of 100ms. The ramp up should be graceful and linear (monotonic).
Table 10-5: Power and Current Specifications
. +5V DC 5%
Power Supply Reguirements
W Pply equl Maximum noise dc to 100 kHz: 10 MV,
Current Drain Wireline Mode 220 mA
. Receive: 220 mA
Current Drain CSC Mode Transmit (Full Power): 850 mA
Deep Sleep: 35mA
. Sleep: 45 mA
Current Drain CDPD Mode Recaive 220 MA
Transmit (Full Power): 850 mA
10.4.4. Heat Dissipation
The figures below indicate excess power dissipation beyond that radiated by the antenna.
Table 10-6: Power Dissipation Specifications
CDP_D and CSC Transmitting at 3.65 Watts
Maximum Power
CDPD Logic Sleep 215 mw
Logic Deep Sleep 175 mw
CSCidle (receive) 1.25 Watts
Wireline 1.1 Watts
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10.4.5. RF Features
Transmitter Power nominal 600 mw into 50 W
Transmitter Performance Meets or exceeds CDPD V1.1 Section 405
FCC, Industry Canada, |S19B/C
. e Data: -108dBm 5% BLER
Receiver Sensitivity Voice: -116dBm 12dB SINAD
10.4.6. Electrical
10.4.6.1. Host (DTE) Interface
The SB320 provides a single 30-pin ZIF connector with 0.5mm pin spacing. This connector
provides four interfaces:
1. Seria host interface
2. Modem control interface
3. Power
4. Statusline interface
The connector pinouts are specified in Table 10-7, and electrical characteristics are specified in
Table 10-8 Seria Interface Electrical Characteristics. Signal types are with respect to the
modem (DCE).
Table 10-7: Host Interface Connector Pinouts
Pin Number | Pin Label Type Description
1 \DCD Output Data Carrier Detect
2 RxD Output Receive Data
3 TxD Input Transmit Data
4 \DTR Input Data Termina Ready
5 GND Ground Ground
6 \DSR Output Data Set Ready
7 \RTS Input Ready To Send
8 \CTS Output Clear To Send
9 \RI Output Ring Indicator
10 \RESET Input Hardware Reset
11 Reserved L eave unconnected
12 \SHDN Input Graceful modem shutdown.
13 \STATUS OUT1 Output Power + RF Channel Status
14 \STATUS _OUT2 Output Transmitter Key
15 \STATUS OUT3 Output Power Down OK
16 STATUS IN1 Input
17 STATUS_IN2 Input
18 STATUS _IN3 Input
19 STATUS IN4 Input
20-22 Unused Allowed to float
23-24 VBAT Input +5V
25-28 GND Ground Ground
29 Unused Allowed to float
30 Reserved L eave unconnected
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Table 10-8: Serial Interface Electrical Characteristics

Characteristic Min.(V) Max.(V)
Input Low Voltage -0.3 0.8
Input High Voltage 25 5.0
Output High Voltage (1oh=400 pA) 24 -
Output Low Voltage (101=3.2 mA) - 0.5

Serial Port Interface

The serial port pins comprise a standard set of serial data and handshaking lines. All signals are
negative assertion, HCMOS logic compatible. These signals must be terminated properly if they
are not used. Unused input signals must be pulled to the appropriate in-active state through a
resistor (10k). Unused output signals may be left unterminated. If asignal may have use asan
input or an output (1/0O) then treat it as an input for termination purposes.

Hardware handshaking should be enabled using \CTS and \RTS as the primary flow control
signals. The remaining handshaking lines \DCD, \DTR, \DSR, and \RI) are, strictly speaking, not
needed; however they are desirable for TCP/IP stack usage and are supported for any applications
that may require them.

Operation in each modeis as follows:
- \RTS,\CTS
Used as standard hardware flow control lines.
\DTR
Indicates to the modem that the host device is active. Thisline may also be configured to
switch the modem from data to command state or reset the modem (AT&D), and to enable
host wake-up. See the RI description below.
\DCD
Is asserted in CDPD mode while online with an active session. Behaviour optionsin CSC
and Wireline modes are set with the command AT&C.

\DSR

Always active when the modem ison; it istied to logic GND.

\RI

In Wireline and CSC modes, this line toggles when there is an incoming cal (the telephone is
ringing).

In CDPD mode, using UDP or TCP packet service, \RI toggles with a 1son : 4s off duty cycle
when there is data for the host or a TCP connection request. If \DTR isinactive (high), the
\RI signal will go active through three cycles; otherwise it will go active once only. Thisis
repeated for each incoming packet or connection request until a session is opened. This signal
may be used to wake-up the host.

The serial port should be configured for 8-data bits, no parity bits, and 1-stop bit. Although the
current firmware release (R1.0.1) isfixed at 19200 bps, the eventual default DTE configuration
will auto-baud to the host serial baud rate (based on speed of the ‘A’ in an AT command). Host
datarates of up to 115,200 bps will be supported. AT commands may be used to fix the baud rate
from 110 bps to 115,200 bps.

In Circuit-Switched mode data state and any mode's command state, a terminal emulation
program may be used to communicate with the modem and change the configuration.
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Modem Control Interface

Modem control is comprised of two inputs:

1 \SHDN: Graceful Shutdown
Thisis an active low input.

When activated this signal instructs the modem to de-register from the network, and
power down. When this activity is completed the \STATUS_OUT3 lineis driven low
(on) indicating to the host that power may be safely removed from the device.

The purpose of this processisto prevent corruption of the data in non-volatile memory.
There is CDPD network housekeeping which goes on transparent to the user. Removing
power or resetting arbitrarily can corrupt thisdata. When the \SHDN signal is detected,
the modem will complete all housekeeping and send the de-register message to the
network before asserting \STATUS _OUTS3.

Timing between the assertion of \SHDN and the reply on \STATUS _OUT3 can range
from a minimum of 20ms and a maximum of 2 seconds. The signal is polled at intervals
of 1 second. Aspects of network traffic at the time the signal is detected also determine
the timing for a giving situation.

The modem must be powered down or reset before it is again ready for use.

2. \RESET: Hardware Reset
Thisis ahardware reset of the modem. Thisinput should be externally pulled high and
driven low for at least 100msto reset.

Status Signal Interface

Status Outputs
There are three status outputs provided. These are active low and defined as follows:

1 \STATUS OUT1: Power, RF Channel Status
Permanently low (on) when power is on but no cellular channel isacquired. This
output is high (off) when the modem goesinto CDPD sleep.
Pulses low (on) once per second with 10% duty cycle (100ms on : 900ms off) if the
modem has acquired a cellular channel.
Pulses low (on) twice per second with 10% duty cycle (100ms on : 100ms off :
100ms on : 700ms off) if modem is registered on a CDPD channel.

2. \STATUS _OUT2: Transmitter Key
Low (on) when the transmitter is keyed.
3. \STATUS OUT 3: Power Down OK

When low (on), thisindicatesit is safe to remove power to the modem or issue a
reset. Thisworksin concert with the\SHDN signal noted above.

Status Inputs

There arefour TTL-level statusinput lines provided. There are currently no features that use these
inputs. They are managed within the modem and may be left floating.
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10.4.6.2. Wireline and Voice Interface

The SB320 provides a 13-pin I/O connector for its wireline interface to the PSTN and for the
voice mode connections to a microphone and speaker (headset or handset). The connector is
positioned on the opposite end of the housing from the serial host (DTE) connector. This
connector provides these interfaces:

1. TelephoneLine Interface

2. Voice Feature Interface

3. Status Outputs 1 and 2

The connector pinouts are specified in Table 10-9. Specific configuration detail for the different
interfaces follow. Signal types are with respect to the modem (DCE).

Table 10-9: Pinout of Wireline and Voice Connector

Pin number | Signal Name Type Description
1 Reserved Leave Unconnected
2 SPKR- Output Speaker Interface negative
3 SPKR+ Output Speaker Interface positive
4 MIC+ Input Microphone Interface positive
5 MIC- Input Microphone Interface negative
6-7 Reserved Input L eave Unconnected
8 \STATUS OUT1 Output Power + RF Channel Status
9 \STATUS _OUT2 Output Transmitter
10 GROUND Ground Signal Ground
11 Reserved Leave Unconnected
12 RING Input Wireline Connection
13 TIP Input Wireline Connection

Voice Feature Interface

Speaker Output

The speaker output is a differential signal used to interface to a speaker amplifier, headset, or
handset. The output signal is AC-coupled through 4.7nf capacitors.

The table below co-relates the output voltage with some sample gain settings.

AT+WVRAGC= AT+WVRVL= Output Voltage (mV,.,)
3 9 28— 190
2 9 24— 160
7 9 7-20

In circuit-switched and wireline data modes this signal is used to indicate call progress.

Microphone Input

The microphone input is a differential signal used to interface to an electret microphone for voice
applications. Theinput signa isunder a4.71 kWload. Nominal input is9 mV,.,. Higher input
levels, up to 100 mV,, can be used with the gain control settings near their minimum:
+WVXAGC=4 and +WVXVL=1.

For developers who desire a single-ended microphone input, the MIC- signal can be connected to
GND.
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Telephone Line Interface
PSTN Line Connection
The telephone line interface consists of two signals: TIP and RING. These two lines should be
routed via a twisted-pair wire to a panel-mounted RJ-11 connector. The PSTN Load Number (5B)
is noted on the back label of the modem.
Note that is provides connection to analogue telephone lines only. Connection to digital PBX
lines is not supported.
Status Outputs
These signals are the status outputs from the host interface brought out on the wireline/voice
connector. They are duplicates of the signals described in Section 10.4.6.1 above.
10.4.7. SB320 Communication Mode Specifications
10.4.7.1. Wireline Specifications
Wireline Data CCITTV.34: 33600 — 2400 bps
CCITT V.32his: 14400, 12000, 7200 bps
CCITT V.32 9600, 4800 bps
CCITT V.22his: 2400 bps
CCITT V.22 1200 bps
CCITTV.21: 300 bps
Bell 212A/103: 1200, 300 bps
V.42 error correction (LAPM and MNP)
V.42bis and MNP5 data compression
Wireline Voice
10.4.7.2. Circuit-Switched Data Specifications
CSC Data CCITT V.34: 16800 — 2400 bps
CCITT V.32bis: 7200 bps
CCITT V.32 9600, 4800 bps
CCITT V.22his: 2400 bps
CCITT V.22 1200 bps
CCITTV.21: 300 bps
Bell 212A/103: 1200, 300 bps
V.42 error correction (LAPM and MNP)
V.42bis and MNP5 data compression
ETC
CSC Voice EIA/IS-19-B
CSC General S-91 (future firmware revision)
10.4.7.3. CDPD Specifications

CDPD Version CDPD 1.1
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11. Multipurpose Interface Board

11.1. Introduction

The Multipurpose Interface Board (MIB) isa
development aid to facilitate testing and
configuration of the SB300 Series modems by L lli" ""‘*
allowing communication using a standard RS-232 : : :
seria connection. It also provides monitoring
LEDs, test points, connections for a protocol
analyzer, and connections for wireline (PSTN)
hookup.

Thereis also support for the SB220 and SB301/302
modems. These supports are provided for factory
level testing only and are beyond the scope of this document.

ki

NOTE

Although the MIB provides support for the full SB Series of modems, it is not intended
to support more than one modem at a time. Attaching more than one modem can
damage circuitry.

11.1.1.

For aquick initial setup go to Section 11.8. To get afuller understanding of the board’s
connections and capabilities sections are provided as follows:

Section 11.2 Board Description with schematic and parts layout reference.

Section 11.3 Power Supply including voltage control and supplying power from a host device.

Section 11.4 Connections describing the various host, modem, and analyzer connectors.
Section 11.5 Jumpers details options and setups.

Section 11.6 Serial Breakout Box describes cross wiring correction and signal checking
Section 11.7 Test Points identifies what is offered and where to find it

Features

The MIB offers these features:
- Supports SB220, SB300, SB302, SB320
RS232 to 5V HCMOS conversion
Interception of 5V HCMOS control signals from host to modem to verify syntax and levels
Intercepted signals are converted to RS-232 for observation by standard seria port
Supports wireline access
Serial port breakout box to resolve cabling difficulties
Serial port status LEDs
Status line LEDs and pullup/down
Current, DISC and KEY test points
Reset button for SB300 and SB320
Annunciator to hear dial tones
Comm Analyzer connectors - 25 pin protocol analyzer
Uses wall adapter for power
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11.2. Board Description

11.2.1. Schematic

See the following two insert pages.

11.2.2. Parts Layout

See the third following insert page.
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11.3. Power Supply

The MIB requiresa 12V DC, 1 Amp power supply. An AC adapter (part number 1900000) is
provided with the OEM Developer’s Toolkit.

This power is converted by the MIB into the 5V (and 7V for the SB220) supply needed by the
modems. It is not designed to support more than one modem connected to the MIB at any time.

Thereis apower switch on the MIB that controls delivery of both the 5V and 7V suppliesto the
modem connectors as well as the 5V supply to the MIB’sown logic. This switch also controls
connection of power from a host side interface to the modem when the power selection jumper
(J21) ison pins2 and 3.

The normal initial setup has jumper J21 (Power Select) set on pins 1 and 2 which will deliver
power to the modem from the MIB’ s power source.

11.3.1. Voltage Adjustment

A trim-pot is provided to make fine adjustments to the 5V supply, accommodating cable loss and
allowing you to test the modem under various power conditions.

CAUTION

The 5V power adjustment will also affect the 5V supply to the MIB’s own logic.
Extreme settings may cause failures of the MIB that should not be interpreted as
failures of the modem.

P
£ @
|

Thereis protection circuitry intended to prevent the trim-pot from setting values high enough to
damage the MIB or modem. The rangeis approximately 5V +5%/—10%.

The 5V supply can be measured at test point TP3 or at pin 1 of the power select jumper (J21).

The 7V supply does not have adjustment controls.

11.3.2. Using Power from Host (DTE)

For userstesting a host connection to a SB300 Series modem, it is possible to power the modem
from the host (DTE) device rather than the MIB. To do this, connect the host to the appropriate
connector and set jumper J21 (Power Select) to pins 2 — 3 (+5V Host).

This power feed is also connected to the main power switch on the MIB.

The MIB’s 12V power supply must remain on to deliver power to the RS-232 / HCMOS
conversion logic. The DTE/DCE seria lines are converted to RS-232, made available at the Serial
Breakout Box, and then converted back to HCMOS at each end.

11.4. Connections
This section provides information on the use of the various connectors on the MIB.

11.4.1. PC Host (DTE) RS-232 Serial Connection

There are two 9-pin D connectors (female) provided on the MIB to connect to standard RS-232
seria portson a host terminal, usualy a PC.

PC Serial Port

This connection is for a PC host device running aterminal emulation program. Communication to
and from this port is delivered via the Serial Breakout Box, to and from the modem.
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11.4.2.

11.4.3.

11.4.4.

11.4.5.

Debug Port
The second 9-pin D connector is for factory level testing only.

Host (DTE) Connection for SB300/320

An aternative to the 9-pin RS-232 serial connector (PC Seria Port) is provided for connecting a
host (DTE) device to a SB300 or SB320 via the 30-pin flat flex ZIF connector at J3 (SB300/320
Host). This connector alows you to insert the MIB between the host and the modem for testing

and monitoring communications.

Serial Signals

The MIB converts the serial communication signals to RS-232 level, presents them at the Serial
Breakout Box and then converts them back to HCMOS level before passing them to the DTE/DCE
ends.

NOTE: In order for this signal conversion to work, the host device MUST supply +5V on pins 1
and 2. It isthis power which enables the conversion logic on the MIB for the host side.

Input Signals

The modem’ sthree \STATUS_OUT signals are passed directly between the modem and the host.
They can also be monitored by the three LEDs (SO1, SO2, SO3)

Output Signals

The host Shutdown signal is passed to the modem via an enabling jumper (HOSTSHDN) on the
main jumper block. With the jumper removed, the shutdown signal is blocked from reaching the
modem.

Power from the host can be used to power the modem by setting jumper J21 (Power Select) to pins
2 -3 (+5V Host). With the jumper in the original position (pins 1 — 2) the modem is powered from
the MIB. See Section 11.3.2 for details.

Host (DTE) Connection for SB301/302

This connector provides a service identical to that for SB300/320 using the 2x8-pin block at J9
(SB301/302 Host). The same signal processing is provided as that described above.

Protocol Analyzer Connection

Two 25-pin D connectors are available to connect a protocol analyzer in the serial signal path.
The female connector is on the PC side of the Serial Breakout Box; the male connector is on the
modem side.

To monitor the communication signals between the host and modem, simply connect the analyzer
to the MIB.

SB300/ SB320 Modem Connection

Both the SB300 and SB320 use a 30-pin ZIF connector. The connector uses the Flat Flex Cable
ribbon (Sierra Wireless part number 2000068) provided with the OEM Developer’s Toolkit.

The connection provides all defined pinouts.

Use care when attaching the ribbon to the connector. Thereis acover clamp that hinges up to
open the connector. Slide the ribbon into the connector with the insulated (coloured) side of the
ribbon facing up. Close the connector clamp by pressing down at the ends rather than the centre
of clamp. The modem has an identical clamp connector.
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Serial Signals

The MIB converts the serial communication signals to RS-232 level, presents them at the Serial
Breakout Box and then passes them to the DTE/DCE ends.

The DCE (modem) side of this conversion can be disabled, effectively disconnecting the modem
from the MIB by placing a jumper on the MODEM DISBL pins of the main jumper block. This
can be useful if you are using a protocol anayzer to emulate the DCE device.

Input Signals

The 5V power comes from the MIB viathe jumper J21 (Power Select). Pins1—2 will connect the
MIB adjustable 5V supply.

All other input signals (Shutdown (\SHDN) and status inputs 1 — 4) to the modem are supplied
from the main jumper block. Placing ajumper on the pins will make the signal active.
Output Signals

The three modem \STATUS _OUT signals are indicated by the three LEDs (SO1, SO2, SO3).
These are lit when the output signal is active (low).

Headset Connection

For those using voice features of the SB320, the supplied headset can connect at J15 (Headset).
This provides both microphone and speaker signal 1/O.

11.4.6. SB302 Modem Connection

The SB302 uses a 2x8 pin connector block. A strap with connectors at each end (part
number 2000067) is provided with the OEM Developer’s Kit. This strap alows connection of the
modem to the MIB at J7 (To SB301/302).

Serial Signals

The MIB converts the serial communication signals to RS-232 level, presents them at the Serial
Breakout Box and then passes them to the DTE/DCE ends.

The DCE (modem) side of this conversion can be disabled, effectively disconnecting the modem
from the MIB by placing a jumper on the MODEM DISBL pins of the main jumper block. This
can be useful if you are using a protocol anayzer to emulate the DCE device.

Input Signals

The 5V power and Shutdown (\SHDN) signal to the modem can be supplied from either the MIB
or the Host (DTE) connection (not the PC Host RS-232 connection).

Modem power can be drawn from either the MIB or the host (DTE) by setting the jumper J21
(Power Select). Pins1—2 will connect the MIB adjustable 5V supply. Pins2 -3 (+5V Host) will
connect the host power to the modem. See Section 11.3.2 for details.

The Shutdown (\SHDN) signal must originate from the Host (DTE) connection (not the PC Host
RS-232 connection). It can be enabled or disabled via a jumper (HOSTSHDN). With the jumper
connector in, the shutdown signal will be passed to the modem. With the jumper removed, the
signal is blocked.

The Shutdown signal can aso be originated at the MIB using the SB3XX SHDN jumper on the
main jumper block. Placing ajumper on the pinswill make the signal active (low).

Output Signals

The three modem \STATUS _OUT signals are passed directly between the modem and the Host
(DTE) connector. Their statusis also indicated by the three LEDs (SO1, SO2, SO3). These arelit
when the output signal is active (low).
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11.4.7.

SB220 Modem Conneciton

Thisis provided for factory testing of older model modems not detailed in this manual.

11.5. Jumpers

11.5.1.

11.5.1.1.

11.5.1.2.

11.5.1.3.

There are five jumper blocks provided on the MIB. Two of these are for the SB220, which is not
covered in this document. The three blocks used with the SB300 Series modems are summarized
below and discussed in detail in following sections.

The main jJumper block is located next to the modem power switch and has eight pairs of pins.

When the jumper is connected it has these functions.

STIN1 Activate the input signals (not currently implement

ST IN2 on the modems).

ST IN3

ST IN4

\SHDN Activate the \SHDN signal to the modem.

HOSTSHDN Enable the \SHDN signal from the SB301/302 host connector.
TP CTRL Enable test point TP5.

MODEM DIS Disable the RS-232 serial connection from the modem.

Thereis aso a3-pin jumper block for power selection. A jumper MUST connect the centre
pin (2) to one of the outside pins (1 or 3) to enable power to the modem.

1-2 MIB power is used.

2-3 Host power (SB301/302 host connector) is used.

A 2-pin jumper block is available to enable or disable the built-in speaker. When the jJumper is
connected, the speaker is enabled.

Main Jumper Block

The main jJumper block (J24) has eight pairs of pins, al labelled. Thefirst four pairs are to
activate the four input signals of the SB320 (not currently implemented by the modem). Two
pairs are for direct MIB activation of the Shutdown (\SHDN) signal to the modems and to enable
the SB302 host interface to trigger thissignal. Thereis one pair of pins for activating TP5 and the
last pair is to disable the modem side of the RS-232 / HCMOS serial signal conversion.

ST INx — Status Inputs

Placing a jumper on one of these pinswill force the signal active. At this time none of the status
input signals are used by the SB320 or SB300.

\SHDN — Shutdown

This jumper forces the modem’ s Shutdown (\SHDN) input active (low). Placing ajumper on this
pair of pinsforcesthe signal on. Thiswill work regardless of the jumper setting of the host
shutdown enable.

HOSTSHDN — Host Shutdown Enable

This jumper enables the Shutdown (\SHDN) signal from the host side interface to be passed to the
modem. Without the jumper installed, the signal will not reach the modem. This jumper does not
activate the signal; only allow the signal from the host connector to be passed to the modem.

If the host side connector is not being used, this jumper should be left open (not connected). This
will prevent afloating signal from the host connector block from reaching the modem.

This jumper isindependent of the forced-shutdown jumper \SHDN).
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11.5.1.4.

11.5.1.5.

11.5.2.

11.5.3.

TP CTRL

Test Point 5istied to this jumper. When the jumper is removed, the test point delivers GND;
when the jumper isinserted it deliversthe MIB’s 5V DC, independent of the modem’ s power

supply.
MODEM DISBL

Placing a jumper on this pair of pinswill disable the MIB’s conversion of the modem serial
connection from HCMOS level to RS-232 level, effectively disconnecting the modem from the
Serial Breakout Box and the host (both PC and direct host side connection). Power and the
control signals\SHDN and \STATUS _OUT1 — 3 remain intact.

Power Select

A 3-pin block is provided to select the source of the +5V power supply to the modems. Placing
the jumper on pins 1 and 2 will connect the MIB’ s regulated +5V supply. Placing the jumper on
pins 2 and 3 will connect the modem to power from the host side connection and remove the trim
pot.

The modem power switch comes AFTER the power selection jumper and can be used to control
power to the modems regardless of the source of the power.

SPK EN — Speaker Enable

A 2-pin block is provided to alow you to disable the speaker in situations where you would prefer
to mute the output. Placing the jJumper on the pinswill enable the SB320 to drive the speaker,
provided the SB320 I/O connector isin place.

The SB300 and SB302 modems do not provide speaker output. The SB320 speaker output is
driven through the wireline connector (SB320 1/0O).

11.6. Serial Breakout Box

11.6.1.

11.6.2.

One of the main functions of the MIB isto provide a means of monitoring the serial connection
between a host and the modem. The MIB converts HCMOS level signals at the modem and at the
host side connection to RS-232 level for monitoring on the LEDs and with a protocol analyzer.

In addition, the two rows of pins on each side of the DIP switch provide test points and
connections to each individual signal. This alows you to cross connect pins to correct cabling or
connector faults.

DIP Switch
The DIP switch is used to make or break the connection between the host and modem for each of
the serial communication signals. When switched to the open side, the connection is broken.

Should there be a cross connection error in the host / modem serial connection, switch off the
affected signals and use the breakout pins to bridge the signal correctly.

The last two switches are not connected.

Serial Connection Indicators

The LED indicators show the status of the serial communication on the modem side of the
breakout box. Red indicates an inactive signal, green indicates an active one. All LEDs are
labelled.
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11.7. Test Points

11.7.1.

11.7.2.

11.7.3.

11.7.4.

11.7.5.

11.7.6.

11.7.7.

There are six test points plus a pair of pinsfor current measurement. The sixth test point is not
used at thistime.

TP1 DISC

Thistest point receivesits signal from pin 30 of the SB320 modem connector and pin 1 of the
SB320 1/O connector. It presents the discriminator output of the radio modem.

TP2 KEY

All modem connectors provide the transmitter key indicator here. Thissignal is also indicated by
the SO2 status LED.

TP3 5V Adjusted

The power output after the 5V ADJ trim pot can be measured here.

TP4 5V Setting

Thistest point is for factory presets only.

TP5 Debug for 5V / GND

Thisis connected to the TP CTRL jumper of the main jumper block and is available for debug
testing the MIB’s power supply. When the jumper is removed, the test point delivers GND; when
the jumper isinserted it deliversthe MIB’s 5V DC, independent of the modem’s power supply.

TP6 Unused

Connected to the SB320 pins 20, 21, and 22, these signals are currently unused.

Current Measurement

Two pins are made available at J26 (Current Measurement) to allow calculation of the current
drawn by the modem. The calculationisbased onV =1 x R, where V isthe measured voltage and
R isaknown resistance (0.1 ohm). Thisformulareducestol =10x V.

Measure the Voltage across the two pins. Thisistypically greater than 1 mV and less than 90 mV.
The current being drawn, in mA, is equivalent to 10 times the voltage measured in mV.

11.8. Reset Button

The reset button sends the reset control signal to the SB300 and SB320 connectors. The SB302
does not support areset input signal.
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11.9. Initial Setup

As shipped the MIB is configured as follows:

Serial communication DIP switches are closed and the two spare switches are |eft open.

Power select ison pins 1 and 2 to use MIB power for the modem.

The following main jumpers are connected:
ST IN1 — ST IN4 (Status Inputs to SB320) These are unused currently and simply
provide a*“ parking space” for jJumpers which can be used as needed el sewhere.
TP CTRL alowing for measurement of the MIB’s 5V power supply.

The speaker is enabled.

The 5V power adjustment is set in the factory for 5V.
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